
ArcGIS
®

 9
Geocoding Rule Base Developer Guide



��������	
�
��
����
���
����	�
���������
����	��
��
	��
���	��
�	�	��
��
����� ��

!��
�������	���
 ��	�����
��
	���
�� "���	
��
	��
�# �"����
������	�
��
�����

!���
$��%
��
���	� 	��
"����
���	��
�	�	��
 �������	
��$
���
�	���
��	����	�����
 �������	
	���	���
���
 �����	�����

&�
���	
��
	���
$��%
���
'�
������" ��
��
	������		��
��
���
����
��
'�
���
�����(
��� 	���� 
��
�� ���� ��(
�� �"����
���	� ������
���
�� ������(
��
'�
���
�������	���
�	�����
��
��	������
���	��(
�# ��	
��
�#�������
�����		��
��
$��	���
'�
�����
���
��)"��	�
���"��
'�
���	
	�
�		��	���*
���	�� 	�
+������(
����(
�,
&�$
-��%
�	���	(
��������(
��
.��/�0,1(
����

!��
�������	���
 ��	�����
��
	���
�� "���	
��
�"'2� 	
	�
 �����
$�	��"	
��	� ��

�����������	
������
��������������	�
�����������

���
	���������
�����������������
��	��
���
���	$���(
�� "���	�	���(
���3��
��	�
���������
����"����
��
�"'2� 	
	�
	��
	����
��
	��
4� ����
��������	�

��
��
����	
�����
	��
����
5��������	
� )"���
����	��
	���
���!���!�634�+�!�6
��57!��

�	
�
�����"�(
"��(
�"��� �	���(
��
��� ���"��
'�
	��
����
5��������	
��
�"'2� 	
	�
���	�� 	����
��
��	
���	�
��
8��
9:����/01;
��	����	��
�(
��(
���
���
<=�&
1.,/>?
8��
9:����/01.
<=�&
1.,/>
���3��
8��
91���1131���1�
<������ ���
!� ��� ��
6�	�3����"	��
���	$���>?
���
68���
9�:����/0/1:
<&@A
1..:>
<!� ��� ��
6�	�>
���3��
68���
9��/�/��
<����"	��
���	$���>(
��
����� �'���
���	�� 	��3+��"�� 	"���
��
����������	��
���	���
������ �
���	�	"	�(
�� �(
�,
&�$
-��%
�	���	(
��������(
��
.��/�0,1(
����

����(
�� �+�(
+��@'2� 	�(
�� A��$(
����"�(
�	���	+��(
�� ��	����(
�� +��(
�� �6�(
�� 4����	� �(
�6�(
���	���
6�	�'���
������(
���
�� !���'�#
���
	�������%�(
�����	����
	�������%�(
��
����� �
���%�
��
����(
�����	����
��
	��
���	��
�	�	��(
	��
�"������
����"��	�(
��
 ��	���
�	���
2"����� 	�����

!��
�����
��
�	���
 ��������
���
����" 	�
������
���
	�������%�
��
�����	����
	�������%�
��
	����
����� 	���
	�������%
�$�����



iii

Contents 1 Introduction     1
������������	����������
����������������������	���������������
����������������������	���������
�������������� ��������!

2 Overview of the rule base     9
�������	��	�"����������������#$
%����&��������#�

3 The match file     13
'(��(��������������������������#�
)�&�������	�����#*
%�����������	�����#+
)�&�,-.�������	�����#!
����	������ � �����������#/
%��������������������$
%�	��0��������1��������������#

4 The command file     23
'(��(�����������������	������������
-���������������������*
�	2����������������������������+
�		��������3.45����	�'5�678.���0���	���������9�		�1�������������:

5 The match key dictionary     29
'(��(�������������������0�	��������0������$
%�	��0����������������0�	��������0�������



iv GEOCODING RULE BASE DEVELOPER GUIDE

12
6 The classification table     35

'(��(�������������������������� ��������+
��������������������������������� ��������:
����������������������� �������������	������!
%�	��0��������1�������������$

7 The pattern file     45
'(��(�����������������������������+
-�����������������!
�����������**
%�	��0�������������������������+$
3����������������������������������+�
.	������������������1;��<1�������������++
�		������������������������������������������+:

8 Developer’s Kit tools     69
=��>.37����	�����3.45����	�'5�678.���0���	�����:$
��������������������������=��>.37������:�
.>�'3-�������:�
��������	�� �������		����0�������������������	�������:�

       Appendix A: Data dictionaries and match rules syntax     75
7����	�����������:+
3����	�������������	������������������������::
�����	��������!:
&����	���������������������!!



CONTENTS v

       Appendix B: Standardization process syntax     93
7����	�����������/�
7����������������������������������/+
������������0�����#$�
������������������� �������#$:
���������������������##$
5����	��������������������##�
���	��������������������#�#
�����������#�/
=�����0�����#��

       Appendix C: Developer’s Kit software tools reference     143
3�(������?�
������������������������������#��

       Appendix D: Matching and standardization file conventions and
limits     149
���(���������	�����������#*$

       Glossary     151

       Index     163





IN THIS CHAPTER

1

Introduction 1
• What is geocoding?
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�����	���@����������������������		�����������@������
��������������������;@0�����	������(������������	������������
�������� 0���������������	�������(��������������������������
������������������������	���1������;@0�����	���������������
��������� ��	����0�	���������1

�����	������������ �����@�������0����@������������	���
�;��������	���� ������������������������		���@����0
����@�A7-���	�@�����(���������������� ��1������������
��	�����	�����������	�����������������	��������0����������
���������������������?�������@����������	�����1����	����0
�������������������������	�������������0�����������@��
������������� ����(��������������������������@������������
�������@�����������������1

How the Geocoding Rule Base Developer Guide
can help you

,�����������������������	
���	���	���������	��������������
���������	��0������		������	��	�"��������������	������
����1��		������	��	�"������������������	���������������
�����������������	��������	��������������� ��1�=�������@
�������		�����������������0���(����������	��0�������
�  ��(���������������	��	�"�	��������0��@����� ��	���� 0�����0
�	����������;������1�7��0������	�����		�����������������	��	�"�����
�������������������������		���@�0���������������	�������
��������������������0���;�	���� �	������������:@�B�����������
����?@���	�������������������	��0������������������������;�����
����� �������1

What is geocoding?
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���������	������������C���������������	���@��		���	���@���	
�������1�����������������	��������������������������1

Reference data


��������	����	���������	����������������� ��������D�46E1�7�
����(��0������������	�����"�	� ���	��0��������������������;
�		�����	�������	��D���E�����(������������������	������
���������������1

&���������	�������(���� �������� ������ ������	����(����	���
�� �����1������� ����	������ �����������	������51=1�����
4�������7�.&���	�5����	�=�����-�����=��(����D5=-=E����0<����@
��(�F	�����A7-���	�@���	�A7-G������1��������(����	������ �����
�����	�������������3�������������0@�������4��1@
>�(����@���	����������1�7���		��������������� ������	����(���
	������ �����@��������������������������"�	��461����0
�����	������	�����@�����������������������@���	�����	F����0
�		�����	�������	�1

Address data

�������	������0���(��0� 0������������1�=�����;���������
���������		���@������������������(�����������	����D�����
����	���@�����@������@���	�����E@��������������C����������	
����������D��������0������@����������������������@
���(������������@���	�����E@���	����������������D���
�;�����@����������������������������������=�����&�����*:���	
%����=�����E1

�0������0@������������	������������	��������������	�������	��	
���������1�7���		�����@���������������@������	��������������
��	�������1�����������@�����(��@���0� ����������	��������
�����	��	�"����������������		��������������������������
	��� ��1

Software

=����0������(�� ����	�����	���	�����������	��������������
�����	����	��������1��0������0@������0�����������������	�����
���������461������0�����������	F��	�	���	�	����������������F
����1

-�� � ������������	���������0�������������������0�(���	�����
�����""0�����������������������������	�	�����	�����������1����
�0������0����������������(�������H�����I�������J�����F
���������������������������@��� ��@���	����F�����������	1

�����	���������������	��������������� �����C�������� ����
��	����	��������(������	�1�7���������	���� ��� ���������������
�������������������������	��������������������0�D �����
�����	������0� ����������������������(��������<��(��
��(��������E���	� ��� ��������������������0�����������������0�
�������1

.=&7?������	�������������������� ���������������%��������
���������0?�-�� � �������&����	�8�������0���1����
��������������������������""0���������������@��������;� �����	
������"� ��@������������ ���� �������	��������(������	�@
�������������������������������������@���	��������������	�������
�����������������������0����D�7=E1

Components in the geocoding process
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General process of geocoding

��������������������������	�������������	�������������� ����J

���������������@����������	���������������(������1����
���������(���� ����������	�������������������1

Defining matching strategies

��������	���������	���������������	���������	���1������0��
��������������������������������@�������������������C�������0��
����	����0������J

K ���������	����	���� ����	�;�	�

K ���������	������ ��������	�

K ���������	�0�������	�����������

K ����	��0������	���������

K ���������0���	�����������(����

K �����������	�������������������0�

������0�����(��������	������C������@�0����������	0���� ����
	��������0���������������������1������0���	������0���
�����������������@�0������	�����	�����0���������	�����������0��
�����������������1���������������	�������	����������������
����	1

������0�����(���	�������	����������	@�0������	�����	�����0����
����	���	�������������@�������������0���������������������
���������������������������1�7�	�;������� �� ������������� �������
����	1�,����������	�����	�����0������		����������������
��������1�.����������� ����		��������������������	��������
���1�������������@�������������0�����	����������������� ��@
�����;��0��@������;�	��������@�����������@��������0��@���	�"���
����	1�6��������������������� ������������0@���
��������*@�B������������0�	��������0?1

Standardization

���������������	����������1�������������@��������������
��������������@������	����������������	�����������	�(�	��������	

Define matching
strategies

Standardization

Blocking

Matching

Review/Edit
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��	���������	��	�"�	����������  ��(������1���������������	
����������@��������������  ��(�����������	� ������	���	
����� ����	��� ��1

��������	����@����������������		����������������@������	�
 ��������	���������		���	�����������	�(�	��������	���	
���(�����������(����@�������	�	@���������	��	��  ��(������
������H�).I�����H�).>5.I1

�������������������������	��	�"�������;�����J

�!$�>���,����=�

�!$�L��������� ��

>���,����L�=����������

=��L�=�������0��

#���#�=��=��=��#��

#���L��������� ��

#�=��L�=����������

=��L�=�������0��

=��#���L�=�������� ��

Blocking

4�������@�����0��������������(������������������������@���	���
������� �������������������������������	���� ��������	1�7�
��C�����������	�;����������	����������������	�;������������	@
������=���	�;1

�������� �������@��(��0������	�����(����	J

����� �������@����0� �����	������	�������(����	J

Soundex

'���������������	������	�;�����������������=���	�;1
=���	�;����	������������������������������������	�	���1�6��
�;�����@�0�����0�������������������%����=�����1�=���	�;�����
���	�%���@����������%����1�=���	�;��������������0�����������
0��������������������������������������0��������	1�=���	�;
����	����������������������������	����������	���� ����
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�������������(�����������������������1�7�������;���������%���
��	�%������ �(�@� �������	�����	� ����	�	�%*$$1

6����		�����������@��������������������������������� �������
(���� ��1������;���"�������������������������0������	������
��������	���������������	�;� ����@�����=���	�;�0�������� �
��	������	����������������@���	�����=���	�;���	������ ����	
���� ��������(���� ��1

�����������;������������	���������������������=���	�;
�����	1

#1 &����������������������������������@���	�	���������������������
�@��@��@��@��@��@��@���	�0�����������������1

�1 ���������������������� ��������������������������������
��������J

 @��@��@�(J�#

�@��@�2@��@�C@�@�;@�"J��

	@��J��

�J���

�@��J�*

�J��+

�1 7������������������������������������������������	1

�1 7������������������������������������	��������	2������������
���������������D ����������#E@���������� �����������1

*1 ���(����������������H������@�	����@�	����@�	����I� 0��		������������
"�������������������������������	�������� 0�	�����������
���������	���������������������������������1

+1 6�����0�������������������?�� �������	@�.=&7?������	���
���	������������������������������������������������;�
�����������������������������=���	�;���	�1

Matching

�������������������	F 0F����	������������������������
	������	����	�	�����������	����	��������������	������1�7������	F
 0F����	����������@������������������������������	�������
���	�	�����		���������������	������������������		��1�6��
�;�����@���������������������;�	�����������������		��� ����
������	�������������;�	��������������������������	���1

�����������(������0���������������@������	��������������0
����������������������	�����<�����������(������������1
5���������0����������������������������0���	�����������
�������������	�"���������	��������������������;� ����0���
����������(��������������������������	@��������������0���
�����������������������	�"���1

���� 
����	��������	�������������������������������� ��
���������� ���������������������������������(��J������������
������	��������� ����������������	��������������@���	��������
����������	��������� �����������������	��������������1

���������������0���������������@������������������	�	���
����	���������������	��	�"�	��		�������	@���������������
���	�	��������1��������	�	��������������������	� ��	�������
�����������	��������������� � ������@����������	���������	��
��� � ������1�6��������������������� ������������	��
��� � ������@�������������@�B��������������?1

�������������������������	� 0����������������
������ ���	� 0�������������1�������������������"�	������(����
 �������$���	�#$$1�������������������������	�	���� 0����
�������	�����	������������������	�	�����������	������1

6�������������������������������@�������������@�B��������������?1
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Review/Edit

,�����������F��������������	����������	������������(���<�	��
����1�7�����������	@�0��������	2�����	�;�����������@��	2��
���������������@���	��	2������������������������1�40
�����������������������������������@�0���������������������
���������������������0��1�'����0�����(���(��0�������������
0�������@�0�������� ��� ���������	��������	�	����0�������1
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How to use this book

���� �����������	�	��������������	�������������������
��	��0���	�������"�����������	��������� ��1�7������������0
�����	�	������(���������������	����	F���������������� �������
�����	����3�(������?�
��1�7��0�������	�����������(����������
���� ������������	�����������7=@�������������	��	����!�1

�������������.=&7��7=����	���@������	��������7=@����=3.�@
���7%=@�%��' 2���@����8������M�&����@���	����)���@���
�������������	����������@���	��0������������� ������� ��	���
�������	�������	����������������	���1����� ����������	�����	
�����������	������ ��������7=����%��' 2�����������N������	@
����������������������	������������ ����� �������������	���
3�(������?�
��1�6��������������������� ���������	������
�������������������@���(�������������	�����0�	������������
������� ������0�����������������������1

�����(������������������ �����������(��0��������	�����	������
�������������������	����3�(������?�
�����	���	��0���������
 ��1�7������������	����0��������������������	�	��������������	
����0��������������������	��0����0���������	��������� ��
��������������������������������0��1��������������������	
�������	����������������������0���������������	�	������(��0��
�� ��������	�����	���������������������������������� ��O�����
0������������"��0��������������������������	����@�0�������	
 ��� ������������������	����3�(������?�
�������������
�	(����	�������"���������0��������� ��1
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(�	��������������������	������������	�������
��	�����	�	���
���	���	������"
�������
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�'	��

�	���
������
�&����������
���������	��	���	
���������������	
�	�	�	��	�
���$�(���������	�������
	�������	���	"������	����	����	���
�"���
�����&����	�$�(�	��������	�����������	�������	��	�
������	��
������������

��	��	���
��	�����������������	���	��������$�4��	�������	�����������	��

	�������������	���������������	������
��	
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The standardization process

���������������	��������������		����������������������
�����		������ ��������	����������������������	���1�7�� ����
	���������		���������������@�����������������������	����@
��	����(���������  ��(����	��		�������������������	��	�"�	
(�����D�����;�����@��).������(����E1�7����	������������������
����������	������������������������D�����		��E@����
���	��	�"�����������������������������������		���	��������
���������������	��������������������������� ������	�	���
��	���������������		������������������0� 0����������������
��������	�����	F��F����	����������1

�����	��	�"�����������������������	��	�"������������	
DP����Q1��E@��������	���	��������������������(�����		��
DP����Q1	��E@�����������������	�������������(�	�������	��	��		��
�  ��(�������DP����Q1��E@���	�����������	��������	���
���	��	�"��������		���DP����Q1���E1��������	��	�"�����
�����������������������		���������� ��@�������P����Q1� �@� ��
���0�������������1�40����������	������������������������������@
0�������������������0����������	������������	���1

Reference File Attribute Table

Address Items
ESRI's
geocoding
applications

Data Dictionary and Match
Rules (<file>.mat)

Match Variables

MatchWare
Engine

Matching Process
Compare to determine match or unmatch

Match Key Fields

Standardization Process:
Commands (<process.stn>)
Match Key Definitions
Keyword Classification
(<process.cls>)
Patterns and Actions
(<process.pat>)

Address Event

Address Field

Relationship between MatchRules and StanRules (standardization process)
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�����	��	�"���������������������	��	�����������	���
�����������������		��1�7���������	��	�"�����������@
���	��	��  ��(������������ ������	�������0���	1�7	�������	
�		������������������������(�	������	�����������������0
����	1

����0�������������	�����	�������������������(���������������0���
�����1������	�������������������������F�����(�1�����(��@
����	�������0�����������������������	� ��������	��	�"�	1�7�
�		�����@�������		���������������	� ������	�������������
����	1�6������������������������C����	�����������0�������������
	���@�������������	��	����!�1

�������	��	�"������������	�D1����;������E������0������
�����	��"�@�	� �����	�@�����������������@���	���������������1
6��������������������� ���������������	����@�������������@�B���
������	�����?1

������������0�	��������0�D1	����;������E�	����������	�����0��@
����	�������@���	�������(�������	�������������������0�����	1�6��
��	������	������������������	���	����������@������������*@�B���
��������0�	��������0?1

������������������� ���D1����;������E�����������(�����
��0���	�����	��������		�����	����(�	�������	��	
�  ��(������������������0���	1�6�����	������	������������
��������������	�����@������������+@�B������������������� ��?1

�����������������D1�����;������E�	�������������	��������	�������
�������	��	�"�������������������	������������������0�����	1�6����
	������	��������������������	����@������������:@�B����������������?1
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�����
����		�����������		�������	��������������������	���
��	�������������1����0����������0����������	�����		��F��F
����������	����������������	��������������������������
�		����������1����(�	��������;��������������1����������;������@
�������9�		�#1���@�%����&��������	�����	����������	��������
������	�����1�6���@�����"�
	��������������0�����(���� ��
����@�����	��������@�����	�������@���	�������(�������	�����
�����		�������	��������	��������������������	���1

�����0�������	�����������������������������(���� ��@������ ��
�����#$%	��������������(���� ������������0�����������������
�0��@���������0�����	@�(���� �������@������������� � ������@���	
�		�����������������1�6�����������������������%����
������	@�������������@�B��������������?1

%����&�������������0���� � ���������������������������1
�������� � ������������������������	��	��	�������������1����
����� � ����0���������� � ����0��������������	���������(������
�����	���������������1�6����;�����@�������������;�	�������������	��
>����������������������		�����	�>���������������	�	�����		��@
��������� � ����0��������(��������������������(����1�����������
��������� � ����0��@�������������������������������������	��������
�������	�	��������������������	1�'���������������	@�������
�����;�	�������������	������������������������		�����	�>�������
�������	�	�����		��@��������������� ������������1

��������� � ����0���������� � ����0��������������	���������
���	��1�������� ������������������������������������ � ����0@
���������������������$1#����$1///1�4������������	������ � ������
����	�����	��������1��������1

6���������������������������	������ � ������@�������������@
B��������������?1

7���		���������)�&���	�%�����������	@�����������������
������	������	�"�
#&'(1�����������	��������������
���C����0�����0������������	1�6����������������������
)�&�,-.@�������������@�B��������������?1

MatchRules
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The match file 3
• Overview of the match file

• VAR commands

• MATCH commands

• VARTYPE commands

• m and u probabilities

• Matching weights

• Modifying the .mat file

(�	���	��������5$&���	%�	�����6����"�	�	���	����������	�
	���	
�
����
������������	������	���	����	
����
���	�"	�������	�����������
�����
	�����	�$�(���������	�������
	�������	����	���	"������	�&��������	����	�
	%����������
	�����"����	��������������	�&��������	������
���"�����	�������$���
������	�����������&	�������������"�������"���������&�
������	�&����
���	�����
 ����"	�������
�&���
��������������	�$
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Overview of the match file

%����&����	����������(���� ������������		������������	���
������������������������������ ������ ��1�%����&�������"�

��������	��������0�(���� �������@�����	��������@�����	�������@
��	�������(�������	�1�,������	���1����������;���������������0
����������O�����;�����@��9�		�#1���1

����)�&�(���� �����������?��������������������#+����������@
��	������������������������������������ ����������������������� ��1
7���		�����@�����������������F�����(�@����������?��������	@
 �����	�������������������	1

The Match (.mat) file

VAR
commands

MATCH
commands

VARTYPE
command m probability

u probability
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)�&�������	������0�(���� �������@�����	��������@���	
������(�������	�������������������1���������������������
���(������������@�)�&�������	���������	������������������
��	���������0��������	������)�&1

Format

������������������)�&�������	��������%����&��������	� ���
������J

)�&

P(���� ��F����Q

P ��������F������Q

P������Q

P�����F(�������	�Q

N���������

������P�����F(�������	�Q�JJL

=O����

AO"�����������

>O������(����� ���D�����;�����@�F#E

/O���������D�����;�����@�////E

RO���������(����

����;��������������J

����������	
���������������������
��

7�������;�����@�����(���� ���=�����>���� ����������������:����
��������!1���������������������������(���	�������(����1
������;�������������������������DNE�������	���	���� ���
�������1

VAR commands
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,�������	������#$%	��������	�����0�������	�������������
���������������(���� ��1������� ������%�����������	����
�(���� ������������0�������������������0��@������	��������	@
(���� �������@������������� � ������@���	��		�����������������1

Format

������������������%�����������	�����	� ����������J

%����

P���������F�0��Q

P��������0�����	Q

P���������������(���� �������Q

P�F��� � ����0Q

P�F��� � ����0Q

SP�		�����������������QT

SP��	�QT

������P���������F�0��Q�JL

���&O���������

397>�O8���<&����������(��

8&9���&O8���<&������������������������������

8&95>�.&�O8���<&���������������0����������������

>5%.&7�O>������

5>�.&�O5���������0��������������������

7>�.&)�89>'-�&O7����(����������������0

Match key field

�������F������������������0�����	���	�����	�������������	���
�����������D1	��E�����1

Reference file variable name

����(���� ����������	�����	��������)�&�������	1

m probability

��������� � ����0���������� � ����0��������������	������@���(��
���������	����������������D�����������������������������������	�����
������	������	E1

u probability

��������� � ����0���������� � ����0��������������	���������
���	��1

6�������������������������������	������ � ������@��������B����	
����� � ������?����������������������1

Additional parameters

����������(��������(�������C����	������0���5>�.&����	
8&95>�.&�J

/$$���	������������������������������	�������

!*$���	���������������������������������������0����� ������0
����	���	��������

!$$���	�������������������������������� � �0��������

:*$���	�������������������������������� � �0�	��������

:$$���	�������������������������������������������0�	��������

Mode

������	������C����	������0���397>�J

A.&'9)�873

A.&'9>588

MATCH commands
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.7��.&

A.&'9)�873���	�����������"������� ���������	� ��������	��
��0���������� ��������������������������	1

6����;�����@����A.&'9)�873���������������U�>V�����	@������	��
��������;���������������;������@���0�"������������������� ��
����	� ��������	���������������� ��1

A.&'9>588���	�����������"�������������	�����(��������������
�����(��1

.7��.&�����C����	������0���8&9���&���	�8&95>�.&�1�7�
��	�����������������������������������������������������	�1���
�;���������.7��.&���������������%�����������	� ����1

����������	������	������������������ !"� ! #
  ! ��$����

�������	������	�������	
��� !"� ! #�  ! 

�����������%&�%��&��� !�� !#

�����������%��%���'��� !� !#

���������������(���)&��� !�*� !#

������&�$	���	�+�,�������,�����+�,��������,�����
 !"""� ! *����-����$&
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VARTYPE commands

����"�
#&'(	�������	���������������%�����������	���
��������������1�����)�&�,-.�������	���	��������������C����0
����0����?����������	1������0���������	��0�����������������
����������@�0�������	�?�������������������������;������������������
������������(���� ��1

Format

������������������)�&�,-.�������	�����	� ����������J

)�&�,-.

P������(���� �������Q

P������Q

�����

P������Q�JJL

>'6&.W�D��	�����������������C����0�����0������	� �
��������	E

����;��������������J

����������	������	������������������ !"� ! #
  ! ��$����

�������	������	�������	
��� !"� ! #�  ! 

�����������%&�%��&��� !�� !#

�����������%��%���'��� !� !#

���������������(���)&��� !�*� !#

������&�$	���	�+�,�������,�����+�,��������,�����
 !"""� ! *����-����$&

����.%��+�,������	-+��/

7�������;�����@�6���8����������(���� ��1������;�������������
���������)�&�,-.�������	����������������%����
������	O�������	� ����������������	������������������1
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m and u probabilities

%�����������	���C���������	������ � ������1

��������� � ����0���������� � ����0��������������	�������������
��������	��������	�����������	��	�"�	��		��@���(������������	
��������������1�7������ ��	�����	���#���������������������������
����	������������	������	1���(�������	���������@����=�����>���
	�������#$�����������������������������������������	������	
D�����;�����@� ��������������������������������� ����
���������	E@��������������� � ����0���������(���� ����
$1/�D#�X�$1#E1��������������� ���������	��@������������������
��� � ����0������ �1

,�������	����(�	��������������������������������� � ����01�)����
���$1/����$1//������0�����@������������0�(����������$1#��������
$1///���������	1���������������(�������������@��������������������
	����������������������	� �����1����������0��������������	
������������������������(���������������0���������������1�7��0���
���������������������������� � ����0@�����������������	����	���
 ������1���������	��������������������������������	���(�����
������������ � ��������������	����������@� ���0���������(�
��������(������������������	����0�������������(�����������	��C���
������1�6������������������������	2��������������	
����� � ������@����B%�	��0��������1��������?���������������1

��������� � ����0���������� � ����0��������������	�������������
��������	��������	�����������	��	�"�	��		��@���(������������	
���������������	1�7�����������	@������������� � ����0���������
����	�������������	��1�������� � ����0����������=�����D51=1E
(���� ���������������	������ ����$1$$$���������=���������	�������
	������������������*$����C���(�����D*$�������������51=1E1���(��
����������	���� �����@������������@*$$�D*$�Y�*$E���� ������1����
=��������������#���������@*$$���� ��������D���@�$1$$$���
��� � ����0E1

7���		������������(�	����������������������������������� � ����0@
0�������	�������������������� � ����01�7���������@�0���
�����������������	� �����@�������$1$#����$1#1

,��������������;�����������������	������ � �������������
������������	�������1���������� � ����0��������������� ��
����	�����0�������������		����������@���	���������� � ����0��
������� ���������������������� � ����01

����������	������	������������������ !"� ! #
  ! ��$����

�������	������	�������	
��� !"� ! #�  ! 

�����������%&�%��&��� !�� !#

�����������%��%���'��� !� !#

���������������(���)&��� !�*� !#

������&�$	���	�+�,�������,�����+�,��������,�����
 !"""� ! *����-����$&
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Matching weights

'����0�����(���������	�������� � ��������������������	@�0������
������������������������������		����������1�7����������	������@
���������������������������� �����������������������������	
����� � �������D�����(��������E1������C��������J

���
��
�<�

7����������	�	������@���������������������������������� �������
�������������#X����	�#X��D������(��������E1������C��������J

���
��
#F�<#F�

���������������������������	� 0��		����������	�(�	���
�������������������	�������������������1��������������	)�����
���(�	����������������������������������	�������������	�����

���@������	�	������������������	1�.=&7?������	�����������
���	�����������0��������������������� 0�#$$���	�������������
���������	�	��������1�.����������������	��������0���������
	��������������	����	�������������� �����������	�����	���	
����������������������������	������ � ������1�7����������������
�������"������������������������������0�������	����	�	���
����0���������������#$$1�,�����(����������0�������;����
���������������������������"��������������		����0����������
���)�����1;1�����(��@�.=&7?������������	�������	���@������
%��' 2���@����7%=@���	�����7=@��������"��������������������01
�����������������������	����	�	����������������	������������
���$X#$$� ��	���������������	���;���������1

Candidates Composite Score

101 199 N MAIN ST
  +   + +     +  +

101 199 MAIN ST
  +   + -     +  +

101 199 N MAIN AVE
  +   + +     +    -

101 199 MAIN
  +   + -     +  -

100

60

85

90

This table shows examples of candidate scoring based on the event
123 N MAIN ST. The higher the score, the better the match.

Examples of candidate scoring
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Modifying the
.mat file
����������	
������������������
������� ����������� ��� ����
�������� �������� �� ���������
�������� ���	

����� ���� ������
���� ������� ������ ��� ���
���������� ���� ����� �� ����
�������� ��� ���� �������


��� ����� ���������� �������
����� ���� ��� ���� �������
��������� ��� ����� �� ��������
����������� ���������� ���
�����������
��������������
����������������������������

���������������������


���� � �����������������������!�
��������� ��� ���� "�����#���
�������
� ��� ���� �� �������������
�����������������������
�������
��� ����� ����"�����#���� �������
���� ����������


���� ���$� ����������� ���� ��� ��
���� �������� ����� ���
��%����
�������
�&������
�������� ������ ��� ����� ����
������
��������


���� ���$� ���� ����� ����
����������� ����� ��'�����
��������
���������� �� �� �����
���$�� ������������������� �� ���
�� �� ������ ������������$���
� ��
����������������$�����������
�������������������������
������ �������� ������� ���� ����
�����������������������������
��������!������� ����������

Adjusting the weight of
the StreetName element

1. Open the us_addr1.mat file in
the geocode folder in a text
editor, such as Notepad.

The .mat file will display. �

�

The .mat file is displayed.
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�2. Change the m probability of
the StreetName to 0.8. This
reduces how much the
m probability adds to the
score, thus reducing the
weight of the
StreetName element.

3. Click the File menu and click
Save.

Tip

MatchRule syntax checker
����������	�
���������������������
�������������������������
�
���������������������������
��
��������
���

������������
������
�
����������������������������������
�

�
���������������������
����� ������!��������
�����"
�
������������������� ������!���
����������

���������������
�����������
���������������� �������
��������� ��������� ���� ���
����������������������
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The command file 4
• Overview of the command file

• Parsing parameters

• Adjusting parsing parameters

• Adding the DEBUG and OUTFILE
keywords to the us_addr.stn file

(�	������
�������5$����	%�	�����6������	����	������	��	�
������	��

�������������
	���	����	��	�
������	��
���&&��
����
�����	��	����������
��7�

�$���$�(���������	����	�������	���	"������	���&&��
����	���
����"�
������	����&��������	����	���
���	���&&��
��"��������$���������
	�����	����	
�����
��������	�����"������	��
�����
���"���������&�
������	&$
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Overview of the command file

����������	���������������������	��	�"������������	���	
������@��������9�		�1��1��������������������0�P����Q1��1
������������������������	����������	� �J

RECORD <record-size>

����P�����	F�"�Q��������"��������������	�������������1�.=&7
�����	�������	��������0�����"���*+1

TYPE <file-type>

����P����F�0��Q��������0����������1�����0�����=�771

INTERACTIVE

����0����7��������(�1

{DEBUG}

U3.45�V@�����������������@�����	����������������������������
����������������1�7������������ �����������������������������	
��	������	���������(�	�������������	������������	����������
�������	��	���������������������������������������	1����
��������������� ������(�	� ������������������������	1

STANDARDIZE <process>

����P�����Q�����������������@������;�����@��9�		�1����
����������������� �����������������(����������1��@�1	��@�1��@
��	�1�������������������������1

{OUTFILE <output-file>}

����P������F����Q@�����������������@�������������������������
���	��	�"�����@������������������������� ���������������������

������	� 0���������������1�������������������� ������(�	
 ������������������������	����.=&7������	�������	���1

{<Parsing parameters> }

����UP-���������������QV@�������������������@�������	���
�(����	������	������1�6�������������������@��������������
B-���������������?���������������1

����;��������������J

�9�		�1��

&.�'&3��*+

�,-.��=�77

7>�.&���7).

3.45�

=��>3�&37A.��9�		�

'5�678.��9�		�1�;�
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Parsing parameters

-����������������D�('�!�#	��	��#
!'�!�#E��������������
	����������������������������	���������	���	�����	�������
������������1�����=�&7-87=��������������������������0� �����
 ��������	�	�������������	��	�"�����1�40�	������@�=�&7-87=�
�����	�J��H@1Z?[NJI1�����=.-87=��������������������������0� ��
��	�����	�����0��������������1�40�	������@�=.-87=�������	�
HDEF<@\]NJI1������	���������������������(���������� 0
�����0����������=.-87=����	���=�&7-87=�1�7����������������
�������	@�����	�������(�����������	1

�����������������=�&7-87=�����=.-87=���������� ��������	���
C�������������1�����C����������������������0����� �����������
���1����@������0��������������	��	�"�����@���0�����������������
=�&7-87=��������(�	�����������(����;���	1�6����;�����@������	
����������	���������������������	���������0���(����;���	1����@
>1�1� ������>����	�������	���	���� �������������	1

�����������������=.-87=��������	�����������������1��0����
�����������	@���	�������0�����������	���	������	���������1
6����;�����@�#��F�*+������������	�D�����EJ�#��@������0�����D�E@
��	��*+1

��0�������������� �������@�������������@�����������������
������ ����������������������������1�'��������������������� �
������	@� ��������������	�������������������	���	���	
�������� ����1�=��������� ����������	���	��������������1
6����;�����@�H#���%����=�I���������������������J�#��@�%���@
��	�=�1

��=�&7-87=����	���=.-87=����������	�����0�����������
=��>3�&37A.����������������������0�����01��������������
�;������	��������������0���������������=.-87=����	
=�&7-87=�����0���	��?�����������������	������1
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Adjusting parsing
parameters
(������ ����������� ���� �������
����������������������������

)�������� �� ����� ������� ���
�������� ��� �����������
����������� ���� �������� ��� �����
��� ������
� ��� ���� ������ ���
����� ��� ������� ������
������������������
�������
���
��������� ��� ������� ���� ��������
��� ���� ������� ���� ������
����������
�����������������
�������� ������� ������������ ���
���� ������� *(������ ����������!
�� ���� �������


1. Navigate to the .stn file you
wish to modify.

2. Right-click the file, point to
Send To, and click Notepad
or another standard text
editor.

3. After the STANDARDIZE
command in the .stn file, add
the parsing parameters.

4. Click the File menu and click
Save.

�

�
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Adding the
DEBUG and
OUTFILE
keywords to the
us_addr.stn file
+������ ���� ���� ��������,�� ���
������ �� �����������
��������� ���� ��������� ����
����� ������ ���� ������� ���
��������,����� ������� ��������
���� ���� ��������,����� �������
-
���������������������./+01
����20���3/��
���	��� ��� ���
�����������


����./+01�$���������������
��������,��� ���� ��������
��������������20���3/
$������� ����� ���� ��������
������� ���4���%����5
����
�������� ���� ��� �������


6�������� ����� ��������
�����������./+01����
20���3/�$���������������
����� ���� ��������,����
�������� �� ����/"6�� ��������
��������


1. Navigate to the us_addr.stn
file in Windows Explorer.
Right-click the file, point to
Send To, and click Notepad.

The us_addr.stn file displays.

2. Add the DEBUG and
OUTFILE keywords to the file.

3. Click the File menu and click
Save.

The us_addr.stn file is displayed.

�

�
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The match key dictionary 5
• Overview of the match key

dictionary

• Modifying the match
key dictionary

(�	���	����������	��
����5$
���	%�	�����6������	����	������	��	�
������	��

�������������
	���	�������&������������	���	������������$�(���������	�����	�
����������������	���	"������	�&������	��
�������������	�����"��������"���
������&���	
���
���"���������&�
������$
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Overview of the match key dictionary

������������0�	��������0@������������1	����;������@��������
��������	����������		�����0� ������	����������������������
���	��	�"�����1�6����;�����@���51=1��		��������������
������������������� ��@������;�	��������@������;��0��@������
����@�����;��0��@���	�����;�	��������1����@��������������	����
	�����	����������������0�	��������0�����1�.��������	��������	��
��������01�������������0�������������(�����������
���	��	�"��������������	�������	������������������������
����������	���1

����������������������������0�	��������0�������0�P����Q1	��1
.����������������	��������0����������������	����������������01����
�����������������J

P����	F�	��������Q��P����	F�0��Q��P����	F������Q��P������(����
��	�Q�SN��P�������QT

�����

<field identifier>

��������	��	����������������F�������������C�������	������D�������F
�����(�E1

<field type>

��������	��0���	��������������������������� �������	������������	1

�J���������������	N�����F2������	@������	��������������� ����1

>J�������������	N������F2������	@������	���������	���� ����1

>=J�������������	N����	����"��������������	1

%J���;�	���������	��������N���������(����������F2������	N
������(���������F2������	������������	1�8��	����"�������
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Modifying the
match key
dictionary
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Adding match key fields
to the .dct file

1. Open the us_addr.dct file in
Notepad.

2. Add the fields you want to the
file—in this case, City and
State—and define the data
type, field length, and
missing value code.

3. Click the File menu and click
Save when you are done with
your edits.

�

�

Tip

Adding fields to the .dct file
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Removing fields from the
.dct file

1. Open the .dct file in Notepad.

2. Remove the field or fields
that you don’t want—in this
case, Zone.

3. Click the File menu and click
Save.

�

Zone has been removed from the .dct file.
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Tip

Removing fields from the
.dct file
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The classification table 6
• Overview of the classification table

• How to get to the classification
table

• How the classification table is
formatted

• Modifying the .cls file
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Overview of the classification table
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How to get to the
classification
table
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1. Locate the .cls file in
Windows Explorer.

2. Open the file in a text editor,
such as Notepad.

The file will display in
Notepad.

Note that if you would like to
use another text editor, such
as WordPad, you may do so,
but make sure you don’t save
the file with any extra
formatting.

The file displays in the text editor.

�
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How the classification table is formatted
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Explanation of classes in .cls file Example of some columns as they appear in the classification table
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Modifying the .cls
file
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Modifying the .cls file to
change standardization
of ordinal suffixes

1. Open the .cls file in Notepad.

2. Scroll down to the ordinal
numbers you wish to change,
for example, FIRST.

3. If you wish to change your
data so it is standardized as
a full word (rather than the
numeral), change the second
column to the full word.

4. When you are done editing
the .cls file, click the File
menu and click Save.

�
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Modifying the .cls file to
change AVE to AV

1. Open the .cls file in Notepad.

2. Scroll down to Avenue (use
the Find tool in the Edit
menu).

3. Change the text in the
second column from AVE to
AV.

4. Click the File menu and click
Save.
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Removing Spanish street
types for datasets that
store prefix types in the
street name field

1. Open the .cls file.

2. Scroll down to Avenida.

3. Comment out Avenida by
placing a semicolon in front
of it.

4. Repeat the process with
Calle and Paseo, if desired.

5. Click the File menu and click
Save.
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Adding new keywords
and standard
abbreviations to the .cls
file

1. Open the .cls file in Notepad.

2. Scroll down to the bottom of
the file.

3. Type the words you want to
add (for example, Close) in
the first column.

4. Type the words as they
should be standardized in
the second column.

5. Type a T in the third column
to standardize as a type.

6. Click the File menu and click
Save.
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Changing abbreviated
names in the address
data to match data in the
reference files

1. Open the .cls file in Notepad.

2. Scroll down to MLK.

3. Change the second column
from MARTIN LUTHER KING
to MLK.

4. Click the File menu and click
Save.

Your address data should
now be the same as your
reference file data, which will
result in much better
candidate scores.
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The pattern file 7
• Overview of the pattern file

• Pattern rules

• Actions

• Modifying the pattern file

• Dealing with street intersections

• Editing intersection .xat/.pat files

• Adding custom routines to the
pattern file
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Overview of the pattern file
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>�������J�U�>V

3���������J�U-3V

5����������	�������	�J�U=>V

=�������0���J�U=�V

\POST_START

<post-execution actions

\POST_END

<pattern>

<action>

<pattern>

<action>

\SUB <action>

\END_SUB
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Pattern rules
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Unconditional patterns
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�XAJ������������	� 0������������������������� ��

^J�>������
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GJ�������������� ��������	
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@��5�A�5�A���������B��(��,�������2


���.%��7�8� ��������,B�1�����C,�D�E,�F
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�;�����@����������������������	� 0��4�#���>���,�����(������	
 ����	�	��J

P�_���_��

����������;����@������������������	� 0�`@������������
��������(������������;���;������������� �������	��������@����
�;�����@��#��41�=�@����������������������	� 0����+��������
4�(	�����	� ����	�	��J

`�_���_��

Special single character classes
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Single token

��������	�����������0����������������	� 0������������	�D]E1

����;��������������J

Y�%�_�]���N������������@�&�����*

End of field
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����������������	������������������1

����������;�����������������a��������������	J

G4�5�H�������1�1�,�3'�"����,����������

Subfield classes
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�����1
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��#��F��%�7>�=�1

����������������F�_�#�����	���������������J

S#T�L�#��

S�T�L�F

S�T�L��

Subfield ranges

��������	�������D ��J��	E������0�����������������������	J

D#J�E������������	�#X���������������������1
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D����(��@������������������������E1

6����;�����J

4�5�@�5�I#J�K����#���@���>��
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����������4� �������(�	��������U�=V���������0�����	1

Universal class

�������������	������DYYE�����������������1�6����;�����@��
�����������YY�����	�������#���%�7>�=�1

�������(������������� ����� ���	������������������	���
���������������������  �	� 0��������1�6����;�����@������������
#���>�%����=������	� ����	�	��J
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�������(���������	����������(��0������ �����������0��@������
��0� ����������1�7�������;�����@��������(�����������������
����^���	��������1�7���������@�'�����	�S#T�L�#���>�%���@���	
'�����	�S�T�L�=�1

Floating positioning specifier

������������	�����������	����������DYE�����	������	��0����
����������������������������������1�������������	�����0
�����������������������������1���������������������	������������
���������������������������������������	1�6����;�����J

G���5�4�����#����
�����������;
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'�����	�S#T�L�����D%�����������������	�����	�������
��������������� ��E

'�����	�S�T�L���

���������������� ����	�������������������������������� ��
������������ 0����0���������������������1�.�������0@��������(����
���������	�������� 0���0�����������������������������	�������
���������������1

7���������������������� ����������������������� ���������	� 0��
���@������;�����@�Y�%����Y�̂ 1

Reverse floating positioning specifier

�����������	��������	�����������	����������D\E����������������
�����������������������������DYE@��;������������������������	
������������������������	����������������������1

��������������������0��������������������������	�������������@
������������	�����������������������1�6����;�����J

L��5�4����
3��,���
�;*�%�,D(2�1M�%�,���)����N,�

�* ;��I�3
11����,����
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��1K

����	�����������������������������������������������	� 0��
��� ��1

'�����	�S#T�L����"���

'�����	�S�T�L�!*$��

Fixed position specifier

������.��	��������	����������Db�E�������������������������
�����������������	�������������������1

b#�L����������������

b��L����������	������

bF#�L��������������

bF��L���������	F����F���������

,��������C�����0������������� 0���������������b��������������
�0��1�.������������������	������	�����������0��J

b�^�L���������	��������������

b���L���������	��0��������

�������������DbE������0���������	������������������	�����
�������@�������������	�����������������������1

6����;�����@�c����3���#���%������8������=��=����8���J

�b#�#���������������c���@�������������	������������������1

b�G�������������������	����������������	@�%�����1

Negation class qualifier

������������	�����	+���������DdE���	������>'�1

=�@�d������������0�����	�����������������0��������;������������
�0��1�6����;�����@�Y�%�_�d������������=57�.���� ����������=57�.
=�&..�1

�������������������0� ����� ���	�����������������������DYE
���0�������� ���������������������1

GO6�5���P�P�E��F�5�A�������������������

���.%��7�8�6�E��$	�F�������)�
�D1�����,���$	�

��������������������������������H=�����&8.=I@���	�=������� �
�;���	�	����=�7>�1
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Conditional patterns

$����������	�����������������������������������0���	��
�������	������������1�6����;�����@���_������������� ����=�
���&8.=���	��).>5.�'6���.��%.&7��=@�������=����	
�).>5.������	�����	��� �����������������������������������
�� ��1

�������������C����	���� ��������������������	��������1�7�����
��������@�����=�����������=�7>�@���	������������	��������
�).>5.�������������������0��1

-��(�	�������	��������(����������������������������0������
������� �������1

Simple conditional values

�����������	�����������	������@�����������	�������0��������	
 0�����C����������	���(����1������C�����0����������D�E����� ���
�������	��	�"�	��  ��(���������	��������������������(��������
�C�����0��������������	1

�������������������	��������(����@������ �����(��������
����0� �����	�� ���C����1�����(��@���������(�����������	�	
��������C����1�����;��������������J

G��P�E��F�5�A�����!��������

���.%��7#8�6�E��$	�F

���������������0��������(�������=���������	� 0�����������
�����1

����(�������� ���������	��� ��	���� �����������	��	
�  ��(������O��������;��O��	�����������������	1������
������ ������������(����0����������(���������	��������� ��
(����1

&�P�E�-���F����������C,�D��-�����1�������
23
11���2
��,���
Q3�!

&�P�E�F�����
�'�D���2��,��C��������1�
�D
�D

QQ��B�
��,���!

=�������@�������	������������	� 0�L�L����L�L1�7���������@
L�L����0����������  ��(������@�������L�L����0�����������������
������(����1�=�����;��������������0�����������������J

G��P�P�E��F�5�A����1���,�1���������C
1�
2�(
33'
2,D�D!

���.%��7#8�6�E��$	�F

&�P�P�E�F�����1������
QQ��B�
��,�����
�D3�11���
����,�����
3�C,�D�C
1������,���!

Series of conditional values

��������	��	�����������	����������������	� 0�	�������������
������1���������������� ��	�������	��������������������
�����1�=�@������;�����@��������	��������(��������� ���������	
������� 0J

��L�H=�I�@�H�)I@�H-8I

��J

��L�L�H=�I�H�)I�H-8I

����������(��������� ������	�����������������	���������������
������1�6����;�����J

4�5���5�9�	:�P�E��$	FM�E���FM�E�-���R�F

7��0���������������������������0@�������������������������������
������	@������	���	���	��	�����1

Tables of conditional values

����������� ���������	��������(��������� ���������	���
�		���������� ��1�6����;�����@�0�����0�������������� �������
0�����(������������������D��������������c����3��@���������c�3@
��	���������c�3��E@� ����������������������������������������1
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������ ����������������	���������������?�����������������������
�� ��1�,������������0��� �����������J

`P�� ������������Q

������ ���������=�77�����������������������������������	�������
(����1

�����0������������������������0@�������������������� �����
(����������������������������������	@������	���������	F��F����	
������	1

6����;�����J

4�5���5�9�	:�P�S1����
��!D
�

���������������� ����������1	������;�����	�����������������(����
�������=>���0�������	���������� ��1

Conditional expressions

�������������	�.�����������������	����C����� ������
����	�����0�����������������������������	1�7������ �����������P����F
������	Q@���P����������F��������Q@������P�����F������	Q1

'�����	����� ����(���� �������@�������������0����������������
��������������	@�������������0���������������0�����	@����������@��
�������@���������������(���� ���8.>���	�-7��1

��	
����������������
�����������������

(���� �������

UV

UV�-7��

UV�8.>

UP��������0�����QV�-7��

UP��������0�����QV�8.>

(���� ��������-7��

(���� ��������8.>

UP��������0�����QV

P����������F�;������Q

����
����������
�����������
����������������

Referencing current operand contents

,������	����������������������������	��������������0������	
������;��������������������������������������	1

65�5479:�T�*    8�������2,D��T�*    

�����������������	�UV���	��������������������������������
������	1

����������������������������������C�����0����@��������	��	
�  ��(�������������	@�����������(���� ��1�7����������@�������������
������������	1�=�����;����������������J

�79:P�E��F8�����1�1�����
QQ��B�
��,��Q�2
(1����
�1�3�1��D��������23
11���2
��,���
Q3�!

original token is greater than

=T=

abbreviation is not equal to

abbreviation and original
token are not equal to

original token is greater than
or equal to

original token is less than or
equal to

original token is equal to

abbreviation is equal to

abbreviation or original
token is equal to

original token is not equal to

original token is less than

!=T=

!=A=

!=

>=

<=

=A=

=

>

<
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�79:P�E������F8�����1�1������������C,�D�������
1��2������1��,��
��
QQ��B�
��,�!

�������������������������������C�����0�������������
�������	@������;�����@���S�UV�PL�H=�I�T@������������������������	
�����������������  ��(������1

Referencing match key contents

�����0��������(���������������������0�������������������������
���0@�������UA-V����A7-���	�@�0���������������������������0
�������1�������������������������0�����	������������	���
 ����1�6����;�����J

45&PF�F5&PFUF5�PF�U.F579�%:TP� #  ?9�%:VP� �  8

�#����
1��U�1������C
'M��%P� �  

Referencing constants, literals, and variables

,������������������������@��������@���	�(���� ��1

>����������������������������	� 0���	��������� ��1�>�����(�
��� �����	�	�����������������������������	�����������
�������1

����;�������������������������������������������J

4�79:P#    8

8����������������������������1����0��������������	� 0
��������������������C����1

��������������0�(���������	�����	� 0�������������(��C����
����J

�6�79:PFF8

)���� ������� ����(�����0������	����	1�����(��@���������
���?���;���	�������������@���	��������������������� ������� ����1
������������������������@���0���� ���������������� ����@�	����@���
��	�������������������0� ����	1���(���� ��?��0������������������

������������������(����1�7�����������������������(����@�����0����
���������1�6����;�����J

7�,1�2,D��P�#��;*8����,1�2,D���1�
�B
��
Q3�!

Referencing the length of an operand

��8.>�C�����������������������������������������	J

UV�8.>J�8�����������������������	

P(���� ��Q�8.>J�8��������������������(���� ��

UP�����F��0F����	QV�8.>J�8�����������������0�����	

6����;�����J

479:��	�P�*85@5479:��	�P�;8��1�
�2���,��
�����
D������$%�,�������,���#��;*@W�"!

7��������������	������������������������������������	@����
����������������������1�=�����������;�������������8.>�C��������
���J

67�������	�P�*8����1������3������,��
�B
��
Q3�!

79�	:���	�P�� 8����1������3������,��
��
�2��X�'
���3D!

Referencing a template of an operand

����-7���D�������E�C������������������������������������
������	J

V79:%$���P�E22�F85T79:%$���P�E�22F8��������,�
��1��������3�1���,1�
3�2,D�1M��!�!��>��*	U

����-7���	������������������������	������ ��������
	���� ���	1�������������������F���������F��� ��@���	����
�������� ��F���������F���������1

'��0������C�����0�DLE���	����C�����0�DdLE������������0� ����	
�����-7������������1
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Referencing a substring of an operand

,�������������������� ������������������	������(���(����
��������1�6����;�����@������������������0�������������
(���� ��������������0�����	1��������������������������������
��������������� ��������� ��������������	���	������;�����
��������������	��������0� ����	1

UV�D ��J��	EJ�=� �����������������������	

P(���� ��Q�D ��J��	EJ�=� ��������������������(���� ��

UP�����F��0F����	QV�D ��J��	EJ�=� �����������������0�����	

�����J

D ��J��	E�L����� �����������	���	����������

#L�����������������������������

F#L����������������������������

=�����;����������������J

A79I@J@#K�P�E�������F854�����������������#*

7����I�J;K�P�EQ2DF8�������1�1�
�B
��
Q3�

79�	:I#J;K�P�E+-��F8������1�1�
��
�2��X�'����3D

=�����������������������(�	� 0����������������������
� ��������������������(����1

Arithmetic expressions

����������	�.�������������� ��P����F�����F������	Q@�P�����F
��������Q@����P�����F�����F������	Q1

������F����������F������	���0� �J

(���� �������

U�P��������0�����QV

UV

�(���� ����������������������J

G �		�����

F � ��������

Y ��������������

< 	�(����

b ��	���

�������F����������F������	���0� �J

(���� �������

�������

�������������������	�����������������������;������1�>�
����������������������	1

.;�����J

479:Y��T�����8��B
3(�����B
��
Q3��������1���I��
C��2��2
1��B
3(���������4��,X���1�,(3D�Q�����
���
��
��W����,�D����,��
�2�����1��
�����K

479:0��P� 8������B����(�Q���D��,(1�1

Combining conditional expressions

���	���������;���������0� ����� ���	�����������������
��������J

]J ��	�_J ��

�������������������;�����	��������������1

=�����;������������ ���	����	���������;������������	�J

479:TP#   �?�9:VP#    8����,(1���(�Q���������
�
����,��#   ��,�#    

479:V#  �5�9:T#   8����,(1���(�Q���3�11���
��#  
,�����
������
��#   

)������������������������C����� �������������������'&����������@
��	����������	������ �����������������	���������1
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Actions

�����(�������������������@������������������	���������
��������	1������������ ����	��������0������@������	���
��������������@����(����������������	����������(����� ��	�����
��������� ��@����0������(��������������	��������������0�����	�����
(���� ��@������(��������� �������1

�������������	���������0� �������������1

Copying information (COPY)

����$/'&	������	������������������������D�������	����
�����������	E1�������������������(����������1����������������
�'-,�������	�����P�����Q���	���P������Q1

����P�����Q����� �����������	@�� ������������	@���;�	
������	@�����(���� ��@���������0�����	@��������@�����������1

����P������Q���0� ������������0�����	��������(���� ��1

6����;�����J

4�5�6�5�������#�����$	���

�-%.�7#8�9�	:

�-%.�7�8�9�	:

�-%.���7�8�9��:

�<$�

�����������X��������C��������������	�������������J

9�	:�P�#��

9�	:�P���$	

9��:�P���

Copying substrings

��� ������������������	����� �������	����������� �����
������	�����1�����������J

�'-,�P�����QD J�E�P������Q

������ ������� �������������������������������	�����������	���
������1�6����;�����J

A�5�4������������������#*

�-%.�7#8I#J*K�9�	:

�-%.�7#8I@J@#K�9��:

�-%.�7�8�9�	:

Copying leading/trailing characters

,��������������0����	�������������������������1���������������
��� �����;�	�������	���������J

D�E �������	���������������������

DF�E ������������������������������

D�E �������	��������� ��������������

DF�E ������������������ ��������������

6����;�����J

T�5�6�5����#������$	���

�-%.�7#8I�K�9�	:

�-%.�7#8I@2K�9��:

�-%.�7�8�9�	:

�-%.���7�8�9��:

�<$�

Copying user variables

������(���� �����0� ���������������	<�������������������'-,1
�����0�����������������(���� �����	��������	� 0������0���������
�����1�=�����;����������������J

�-%.�7#8�������2,�'�
��,���
�D

�-%.�E��$	�F�������2,�'�
�3����
3

�-%.�����#��������2,�'�
�B
��
Q3�
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Copying match key fields

,����������0���������0�����	������������������0�����	1�'��
�;��������������J

�-%.�9�	:�9��:

7�������;�����@�����(��������U�>V��������	����U��V1

Copying standardized abbreviations (COPY_A)

,����������0��������	��	�"�	��  ��(���������	�	�������
��������������� ����������������	������������1���������������� ���
��������0�����	����������(���� ��1�6����;�����J

4�5�6�5����#���&�.�-	����	��

�-%.�7#8�9�	:

�-%.�7�8�9�	:

�-%.���7�8�9��:��2,�'�������1��
D�,�����	��

Copying with spaces (COPY_S)

D$/'&0�E������(������� ����������	������0������0
����1�����;��������������J

4�5�6�5���#���-�&������.��$����&

�-%.�7#8�9�	:

�-%.���7�8�9�	:��-�&������.��$��

�-%.���7�8�9��:

Moving information

�����0��������(��������������D�/"(E@�����������������	
D��	������E��������������(�	1�������������������������'-,@� ��
�'-,�	���?���������������������������(������������	1

,��������������������	������(��������(���� ����������������0
����	��������������������0�����	1�6����;�����@�0�������	�	��������
�������������J

�-���9�	:�9��:

�-��������9�	:

Concatenating information

,������������������������������������������������'>���
������	��������-&.67R�������	1�����$/,$�#	������	
���������������������������������(���� ����������������0�����	1
�������������� �����������	@����������@����������(���� ��1�6��
�;�����J

45&PF�F5&PFUF5�PF�U.F579�%:T
P� #  ?9�%:VP� �  8

�#����
1��U�1������C
'M��%P� �  

�-%.�7#8�9�	:����,B���,(1���(�Q����,�9�	:

�-%.�7�8�����

�-	����E�E�����

�-	����7�8��������2,�2
�������U���

�-%.������9�	:�����,B���,�1�������
��

�-%.���7;8�9��:����,B���U.��,�1�������'������3D

,������������������������������	��	��  ��(�������������
������	�����	$/,$�#0�1

����'
(1!2	������	��		����������������	�������	�������
 �������������������1

'
(1!20������0��������;��������	��	��  ��(������������	���
��������	���1��������������� �����������	1
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Converting information (CONVERT)

$/,"(
#	����0������(����	���������	������������������ �������
���F������	��������1

����������������������������;��������������=�77��������	�1� �J

����������������� �(��������������(����@���	���������	�������
������������������(����1���0���������@�������������	����
������	����	�� ���C����1

'�����������������0����������������	�������	������	����������
����������0�������������0� ����	1

����;��������������������'>).&���J

]�N���0������

�-	�����7#8�S2,D�1!�Q3��Z	

�
>���	�������������������������� ��������	�����������0�������0
����������	<���������������������	�������������������������������
��������������������������������������������������� ��1�7�
����������������������������0����������������1�7��0������0�����
�������(������������	����������������������������@�����.%-
�����	1

Retyping operands (RETYPE)

&.�,-.����� ����	������(�����	��������������1�,�������������
�����0���������������	���������������� ��@������������(����������
������	@����������������  ��(�������������������	�������������	���
������������������� ��1

�����0������&.�,-.@����������������	� ����������J

&.�,-.�P������	Q�P���Q�SP(���� ��Q�_�P�������Q�T�SP(���� ��Q�_
P�������Q�T

,��������������0������������	�����������D$E�����������������
����(�����������������1�6����;�����J

0��5�?�����#�����$	�����%��*W

�-%.���7#8�9��:

�-%.�7�8�9��:

���.%��7#8� ��������,B�1��%�

���.%��7�8� ��������,B�1�*W

7��0�����������������������������0�����	���������������;������
�����@����&.�,-.J

GO6�5���P�E��F�5�A

���.%��7�8�6�E��$	�F��2�
���1������,X����'����,�6

�D����3
2�1�����,���$	�

���������������������	��	��  ��(��������������������	J

�P�PF��F�5�4

���.%��7#8����E��$��F�E���F���2�
���1����
1�
�D
�D�
QQ��B�
��,��,����$����,����

Retyping multiple tokens (RETYPE)

�����0����������0�����������������������������������@���
P���QYP���Q��������	� 0������	��	�&.�,-.���������
������������������	�S#T1�������� ��@���������	������������� ��
�����������������������	@����� ������������������$�����**1�A���
�����������������������������	� �������	1�����;������������
����������J

 �G�@�����#��@;*���$	���

���.%��7#8� ������,B�1�
33��'����1���,���,X��1!

001

002

003

"SILVER SPRING"

BURTONSVILLE 800.0

LAUREL
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Soundex phonetic coding

=���	�;���	�����������������0�������������������� �������
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Writing subroutines (SUB, END_SUB)
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Returning from a subroutine (RETURN)
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Modifying the
pattern file
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Encoding the .xat file

1. Open the .xat file you wish to
modify in Notepad. The .xat
files are located in the
geocode subfolder of the
Geocode folder.

2. Make any changes in the .xat
file.

3. Click the File menu and click
Save.

4. Open STANEDIT.

5. Click the File menu and click
Open Process.

6. Click the .stn file you wish to
use (has the same filename
as the .xat file you modified).

7. Click the Tools menu and
click ENCODE PAT.

ENCODE PAT converts the
.xat file into a binary file with
the .pat file extension.

�

�
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Adding quickly filterable
patterns to the pattern
file

1. Note in the address:

123 23rd St. Ct.

that 23rd St. represents the
street name, and Ct.
represents the street type.

2. Open the us_addr.xat file in
Notepad.

3. Add the following pattern at
the top of the .xat file:

Pattern is:

4�5�?�5���5����
1�
�D
�D��,���,��#������D
��!���!

�-%.�#�9�	:

�-%.�������

�-	��������

�-	������7�8�����

�-%.������9�	:

�-%.���7;8�9��:

�<$�

4. Click the File menu and click
Save.

5. Open STANEDIT (for
information on using
STANEDIT, see Chapter 8,
‘Developer’s Kit tools’).

6. Click the Tools menu and
click ENCODE PAT.

The .xat file is converted to a
binary .pat file.
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Modifying the .pat file for
a special circumstance

1. Open the us_addr.xat file in
Notepad.

2. To quickly process the
special case for “Trail West”,
add a section to the top of the
.xat file with the pattern
outlined in the graphic to the
right.

3. Click the File menu and click
Save.

4. Open STANEDIT.

5. Click the Tools menu and
click ENCODE PAT.

The .xat file will be converted
to a binary .pat file.
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Dealing with ST

1. Navigate to the .xat file you
wish to modify (default
location is C:\programfiles\
ESRI\GeoKit\Geocode).

2. Right-click the .xat file, point
to Send To, and click
Notepad (or another
standard text editor).

3. Add the text in the example at
the right to the top of your .xat
file.

4. Add the text in the example at
the right to your .xat file after
your pattern–action
sequence pairs.

5. Click the File menu and click
Save.

6. Open STANEDIT (default
location is C:\program
files\ESRI\Geokit\Bin).

7. Click the File menu, click
Open Process, and click the
process you are working on
(same filename as the .xat
file you modified).

8. Type an address to be
standardized in the text box.

9. Click the Tools menu and
click Encode PAT.

The .pat file is outputted to
your geocode folder where
the software is installed (for
example, if you are using
ArcGIS, the default location is
C:\arcgis\arcexe83\geocode).

�
�

�



64 GEOCODING RULE BASE DEVELOPER GUIDE

����		����0����������������������������������J

K -�����0��������		��@������;�����@��9�		�#1���

K =�����������������@������;�����@��9����1���

.��������������������������������	��	�"�����������1

���������������������������������	������������������������
���	��	�"�	@�����		�����������������������	�������@������1��@
���� ���		�	���������		����0��1

����������������������	��	����������	���������������
���	��	�"��������	�����������������������������1

Matching and standardizing street intersections

����		����0��������������������	��	�"��������	���������
��������������������������������		��������������������		��
���	��	�"��������	���������������1

=������������������������������0��������������D���E��������
�0��1�40�	������@�����������������������	�������	� 0���
�������	�D]E1�7��	���?�������������������� ��1�����;��������
���������������������J

>�=�����=������]�%�����(�����>.

Defining MatchRules for street intersections

�����0�������	��������%����&�������������������������@����
������������(���� ��������������������������	������	
�����	��������	�������������	� ��	�����	1�6����;�����J

)�&�-��3��# # ���R�N�-����;�	���������#

)�&�-���0��# � ���R�N�-����;��������0���#

)�&�=�����>������#: �!�=�N�=�����������#

)�&��0��# �* +��R�N�=����;��������0���#

)�&�=��3��# �# ���R�N�=����;�	���������#

)�&�-��3��� �� ���R�N�-����;�	����������

)�&�-���0��� �* ���R�N�-����;��������0����

)�&�=�����>�����/ �!�=�N�=������������

)�&��0��� :: +��R�N�=����;��������0����

)�&�=��3��� !� ���R�N�=����;�	����������

7���		�����������������������������(���� ��@����������������
����������������	�	J

%�����5>�.&�����=#���=�����>���#���$1/�$1$#����:$$1$

%�����5>�.&�����=����=�����>�������$1/�$1$#����:$$1$

%��������& �������-#���-��3��# �����$1!�$1#

%��������& �������-����-��3��� �����$1!�$1#

%��������& �������.#��-���0��# �����$1:�$1#

%��������& �������.���-���0��� �����$1:�$1#

%��������& ��������#���0��# �����$1!*�$1#

%��������& ������������0��� �����$1!*�$1#

%��������& �������3#��=��3��# �����$1!*�$1#

%��������& �������3���=��3��� �����$1!*�$1#

Writing pattern rules for street intersection
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Dealing with street intersections
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1. Look at the graphic on the
right to see how the .dct file
parses the address into
components.

2. Navigate to the .xat file you
wish to modify in Windows
Explorer (the default location
is at C:\program
files\ESRI\GeoKit\Geocode).

3. Right-click the file, point to
Send To, and click Notepad.

4. Type the pattern at the right
in the .xat file. Note that \&
denotes you are looking at
an actual ampersand in the
address, rather than an
operand.

5. In the very last line (after
EXIT), add a carriage return.

6. Click the File menu and click
Save.

7. Open STANEDIT (default
location is C:\program
files\Esri\GeoKit\Bin).

8. Type an address to be
standardized in the text box.

9. Click the Tools menu and
click Encode PAT.

The .pat file is outputted to
your geocode folder where
the software is installed (for
example, C:\arcgis\
arcexe83\geocode).

Editing
intersection
.xat/.pat files
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1. Open STANEDIT (default
location is C:\program
files\ESRI\GeoKit\Bin).

2. Click the File menu and click
New Process.

3. In the Save As dialog box,
type the name of your new
process, then click Save.

The files that make up the
standardization process
open.

4. In the .xat file, add the
pattern–action sequence to
standardize your address.

5. You can also add a custom
routine, for example, to
remove directions. This is
useful if you want to stan-
dardize the address without
worrying about the {PD}
field.��

Tip

Actions in the .xat file
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Adding custom
routines to the
pattern file
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6. Type the text in the graphic at
the right into the .xat file.
DIRECTIONS is the name of
the subroutine.

RETURN in the pattern–
action sequence at the right
is what moves the action to
the next pattern.

A [2] is used under COPY_A
[2] under \SUB_DIRECTIONS
because the subroutine only
deals with direction; this
removes direction to
streamline standardization.

7. When you are finished, click
the File menu and click Save.

8. To create a new process, you
need to add PD and ST to
the .dct file. Add the text at
the right to the .dct file you
just created. For information
on adding fields to the .dct
file, see Chapter 5, ‘The
match key dictionary’.

9. You need to update the .cls
file. Add the text at the right to
the .cls file you just created. It
should replace the “0 0
0” line. For information on
adding fields to the .cls file,
see Chapter 6, ‘The
classification table’.

10. Open the process in
STANEDIT and enter an
address to standardize.

11. Click the Tools menu and
click Encode PAT to convert
the .xat file into a .pat file.
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Developer’s Kit tools 8
• STANEDIT and the DEBUG and

OUTFILE keywords

• Creating a new process with
STANEDIT

• ENCODPAT

• What to do before adding your
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STANEDIT and
the DEBUG and
OUTFILE
keywords
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Adding the DEBUG and
OUTFILE keywords to the
command file

1. Open the us_addr.stn file in a
standard text editor, such as
Notepad.

The us_addr.stn file displays.

2. Add the DEBUG and
OUTFILE keywords to the file.

3. Click the File menu and click
Save.

The us_addr.stn file is displayed.

�

�
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Using STANEDIT to
standardize an address
using us_addr.stn

1. Click Start, point to Programs,
point to Esri, point to
Standardizer Editor, and click
Standardizer Editor.

2. Click File and click Open
Process in the Standardizer
Editor window.

The Open dialog box
appears.

3. Click the us_addr.stn file in
the Open dialog box.

4. Type the address you wish to
standardize in the
Standardizer text box and
click Process.

The address will standardize
in the Standardizer Editor
window.
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Tip

Entering multiple
addresses
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Tip

Checking pattern rules
syntax using STANEDIT
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Creating a new
process with
STANEDIT
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����� �������������� ����� ����
����� ������ ����� ��������� ����
1��������.��������!��E�
� ��
���� ������ ���� ���� ������� �����
���������
��������������� �����
������������������ ������$
�������	
��� #�	����� ����� ����!�
������������� ��� �������������
�������� �������� �����������
/"6��1�"���������
������ ������
���� ��%����� �������� �����
���$�� ����&������� ����������
���� �������� ���� ���� �����
��������
� ��� �����������$��
���� ���������� ����� ���!�� ��
���� ���� ��%����� �������� ������
������������� �����������
����������� ���� �����


1. Click Start, point to
Programs, point to Esri, point
to Standardizer Editor, and
click Standardizer Editor.

2. Click the File menu and click
New Process.

3. In the Save As dialog box,
type the name of the new
process, then click Save.

The files open in a text editor
(the default is Notepad).

4. Edit the files and add the
rules accordingly (for
information on editing the
files, see the section, ‘Adding
custom routines to the
pattern file’ in Chapter 7).

5. After you have edited each
file, click the File menu and
click Save.

�

�
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ENCODPAT
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Encoding the .xat file
using ENCODPAT

1. When you are finished
standardizing and debugging
your process in STANEDIT,
click the Tools menu and click
Encode PAT.

If you are running
ENCODPAT from STANEDIT,
the .pat file will be outputted
to the same folder where all
the other files in the
standardization process are.

If you are running
ENCODPAT from the DOS
prompt, the .pat file will go to
the current folder of the
prompt if you don’t specify a
path for the .pat file.
Otherwise, everything will be
saved to whatever folder it
shows after the prompt.

Tip

Running ENCODPAT from
DOS
4�������
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What to do before adding your files to the folder
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Data dictionaries and match rules syntax A
• Introduction

• Data dictionaries and match
specifications

• Geocoding

• Record linkage concepts
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Field preparation
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Match Specifications
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Data dictionaries and match specifications
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Specifying the m and u probabilities
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Character comparisons (CHAR)
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Counting errors in fields (CNT_DIFF)
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Date comparison types
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�;�����@���	�����������������	�0�����������	��������4�(������
��������D�	����	����������������������	���E@���	���	������������
"��������������	����������(�����������D�	����	��������������������
�����	���E1

Delta percentage comparisons
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Distance comparisons (DISTANCE)
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��������"���@����������������������������������	1�7�����
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Interval comparisons
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 ������	���	��������1�'�������@��������	����������1�7����(��
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Interval comparison with parity
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��� ����������������������	������������(�����������61�7�����
��� ����������������		@���������� �������������� �����������6
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�����(�����������6��(���������� �������������������������������	
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Left/Right interval comparisons (D_INT)
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����������1

.;�����J

�!��./���� ��/34���0�3!���0���3���0��0�3!���
�3����$8999�8$"�5��3������

��������	�/34������������	������������������(���D0�3!���0�A
�3���0�E���	����������������(���D0�3!���A��3���E1����������
�������������������	����	����������������1



APPENDIX A 83

Left/Right character comparisons (LR_CHAR)
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Left/Right uncertainty character comparisons
(LR_UNCERT)
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Numeric comparisons (NUMERIC)
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Prefix comparisons for truncated fields (PREFIX)
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���������6�.�3!6&�����	� ����������	�����6�.�3!
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Prorated comparisons (PRORATED)
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Time comparisons (TIME)
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Character uncertainty comparisons (UNCERT)
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Record linkage concepts
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Objective of record linkage
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' (����0@�����������������	�����������������(���C��(����������	
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��	�����������������	�������������0� ��	������������������C��(�����
����	���������61
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���������������������� ��������	�����1�������������������	� �
�����	���������������������������	�#�����������61�������;������
����	� �������	�������������������	������	�������������6@������
��%�*����������������	@������������������ �����������	��������
����	�*���������� �����������	���������61

����� 2����(��������������	�������������������������0�����
������� �������������������������J�����������������	������	
����@�!@���	�������������������	������	�����@�41�6����;�����@���
0���������������������������������	�����������	�"#=���������������
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 ������������4@�������������������	� ������������!1
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����1�����������������@�����	�����������������#@$$$������	�����1
����������#@$$$@$$$���� ��������	�����@� ������0�#@$$$���� ��
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Feasibility of record linkage

7����	��������������	������������������������ ������ ��@��������	
 ����� �������������������;��������������������	�������0
�����	�������������	������C��(����������	�������0������	���������6@
��	�	������������������ �����������0���������������	�����
�;�����	������������������������1

6����;�����@�����������0�����	����������� ������������������
���@������������	��0��������������;������	@��������������
���������	�����������	�(�	���1������(��@���� �����������������	
������	�������=������=������0�>�� ��@������0�������	�����������
�������������������@�������������	�����������	�(�	���1
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�������������� @����	�������������������	����������������������
���� ��@�������������0�������� ������(�����������������	@���	
���������������	���������������� �����������	���� ��������1�7�
�������	������������������������������� �����������	@����
����������������� � �0����� ��1

6����;�����@������������	����@��@�@���	�*���������
����������������0
����	����������	���(�����������������	@�������������������
����������������	� ����	�J��������������� ���(����@��@����
�������	��	@���	�*���������
������������0F�;1������0��
�������0�������� ���(����������������	@�0�������*@�$$
D��;�#$$�;��+E1�=������������������0�*@�$$���� ���(������������
����	@����0�(��0������	���������� ��������	��������0
�����	����1�������� � ����0�������������������������	�������;���
	�����������	�	��������������������������	�(�	���������������
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Blocking

6�����0������� �0��"�	�����@�������������� �����������������
�����	������������������ ��������� �����������������	������
������� �����������	�������������1�.(���������������������������
���#@$$$������	���������#@$$$@$$$���� ������������;�����1�'�
�����������@�����;��������#@$$$������ ��������1�����������///@$$$
������������	�����1�7�����������������0�������������������
�����	���(�������������� � ����0���� ��������������	���������
��������������������� � ������@�������������	� �����
��������������0����� ���������	�������������������������������1

6���������0@����������������E���F��@����(�	���������	���
���������������� ����������� ������;�����	1�7�������������
���������� ���������������������0��;����(����	��;�����(�
� �����	����0���������������������������� ��@���������
���������������������	� ������������� ��1

�����	�����	���������������� �������@�����	���������	������
�@�1�7������������#$$���� ������@����������(���� ��������������
����������#$$�� ��1����������� ������������������������������
"���@�������;������������������������#@���	�����1������� ��
���������	�E���F��D������F�
���������0���E1�=�����@��������
��������;�����@��������������(������������������0�	���� ���	1�7�
�������@������������#@$$$F�����	�����@�����������	� ��#$������	
������������������$�������������@�#$������	�������������������#@
��	�����1

�����������������	���� ���������	���������������������	�������
���� ����1���������� ���������	���������������������������$
������������	�61���������	� ��#$�;�#$����#$$������	�����1����
����	� ���������	��������������������������������	�6��������
�������#1���������������������������@�0�������	���(�
�������	�#$$�D ����E�;�#$$�D���������� ����E�L�#$@$$$�����@
����������������#@$$$@$$$������	��������C����	��������� �������1
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 ��������(���� ��������������	1�'�������C�������������������
�����	������	��?��������������� ��������(���� �������
������������0� ���������	������������	1�6����;�����@�������
 ��������(���� �����������@���	������������������������������
����@���������������	���(��(�	���������	���	���� ����������	1
������������	�������� ���@�*:�
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�����	������	���������������� ����������	�������������
 �������������@������;�����@���������	��������	����1�7���
�����	�	�	������������������������#@�������������������
����������0���������������������	���������1�7�������0�����
�����������(����������� ��������������	���������	������	�����
��������� ��������	1�7������������2������ ���@������������	���
���� �����������	��������� ��������(���� ��1�.�����������������
 ��������(���� ��������������01



90 GEOCODING RULE BASE DEVELOPER GUIDE

Selecting blocking strategies

7������	� ��� (��������������;������� �(�������������� ����
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����������������������+*@*�+����������� ����1�������������C����
 �������������	�����	���(���*+������	������������������	���
�*+������	���������61���������������C����� ���������	���(�
*@$$$������	�������������	�#�������	���������6@����(����(���1����0
��� ������������"�������	���?���;���	�+*@*�+��������
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��������0����������	����������	@���	�����������	�����������
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Weights

������������������������	��������(���� ������ ��������	�����
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�;�	�������#$���������������������	�����������������������������
 ��������������������	@����������*���� � ����0���������(���� ��
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�������������� ���������	��@�����������������*���� � ����0������ �1

����:���� � ����0���������� � ����0������������	���������(�������
���������	������ ������;�����	��������������	�����1�=����������
���������0��������������	��������� ��������������	�����@
������� � ����0����������(��0�������� � ����0��������������	������
������	��1�6����;�����@�������� � ����0�����������;�(���� ��

������������	������ ����$1*1���(�������������	���� �����@������
������������ ������J

6����� 6����4

% 6
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6 %

6 6
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���������������(�	����������������*���	�:���� � ����������
���������	1
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=������0�>�� ���(���� ��J
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>�� ���������$�������������������1
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� �(���� ��E1����@�����������������;������e��D�<�E�L���D�<�E<
��D�E�L���D$1/<$1*E<��D�E�L�$1!*1

�����(���(��0@������������������ � ����0��������������������
���=������=������0�>�� ������������#$��������1���(���*��
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Composite weights

6�������������	�������������	@����������������������������	
��	�����	1���������������������������������������	�(�	���
�������������������	����������1

7��������	������������������� ������������	@���������������������@
���������	�� �(�@�����	1�7��������	�	������������������� ����
�������	@�����	���������������������������	��J����X��SD#F�E<
D#F�ET1������������������	�	����������������(����������(�
������1����@������������		��������������������������	
	������������ ������������������������������1�����������
��������@��������������������������1

�����������������������	����������������������	���� ��������
�������������������1��������������������0�(�������������0
������(��������� ��������������������������	�����N
����(��@�������������	����������	��������������������
�����	������	������@���	����@�������(����������������������
����1�����������������H��	�I���������0������(������������
����������	����1������������(��������������������������� ����
 0�����������������������1����������������(���������������	� �
���������������������H ���I��������������������������������
�;�@���	�����������������������������	� ��������������������	
������������	�������1�.;����������������	��;����������������
�������������� ������	�����������������������1

Estimating probabilities

,�����������������������	������ � ��������(������0�����(����
�	����������������������(����1�'���(����������������0������	
����������������� � ���������$1/1��������������������� � ����0@
����������������	����������������������� �1����������@����������	��
���������@���������� � ����0����� �����������(����1�7�������
��� � ����0�������@����������������	�����������������������	����
������(���������������	�����@���	�����C�����0�����������0������

���������������1�������������������	������������� � ������
����������	� 0������������@����������������� ���������	1

��(����������	��������������������������	������ �������
����� � ������@���	���(����������	���������������������������
���������������������� � ������1���������� � ����0���������0
 ������������������������ � ����0@���	����������(��� ��"����������1

��������� � ����0����� ������	1������	�����������������
�������������� � ����0�#<�(����@��������(�������������� �����
���C���(�����������������	1�6����;�����@��;��������(����@����
���	������������������ � ����0���#<��L�$1*1

7����������������������������(����;���������������� 2����������
����������������������� � ���������������@�������������� ��
�����(�����������	��������	��������0���	���������������������
��	�(�	���1

Endnote

�������������������%��������������������@�7��1@���;���������
�����	�;�����	����	�����������5�'%�����5��?�%�����
D(�������1/E� 0�.=&7@��!$�>���,����=�1@����/��:�@�51=1�1
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Introduction

7�	�(�	��������@��������		���@���	�������0�����������
����������������������������������������1�6����;�����@��������
����	�����	��		�����0���������#���%����=�@�����������#$�1��
���������	�����	���������%�1�c����-����c���1

����������������������������	����� �����	��	�"�	���
�����������������������(�������	��	�����C����	�����������
������0�����������"��������������������������1�-�����
��C����������	��	�"�����������	���		�����������@���	�(�	���
��������@�������������	����������@���	�����1

�������	��	�"��������������(��(��������������������*�
�7
F�,1�������������0������������	�(�	��������	�����������������
����������������		��1��������	��	�"����������������������
�����������������������@��������"��������������@���	���(�������
��������������������	����������������01�7���		�����@���0���	���(�
���	��	�"�	��  ��(������1

���������������������	��	�"�������������0�������	���������0@
�����������������	�(�	��������	��������	� 0�������������������
�����	1������������������ ������������	� 0��(������;�����1

=��>.37�����������	���(�������������7��������(�
=���	��	�"��@���	��������	������������������0���;������������	
	� ������1�����	�������������������	�;���������
=��>.37�@�������������������������	�	� �������������������@
��	�������������������������(�������1

Postal addresses

6���	�������������������		��������������������������
������;���������������������	1��		��������������(�����0���
����@���	��������"��������������������������0�����������
���	�����������������������������0����	1�6��������	�����0
������@�����	���������������	���������0J

�������� ��

3��������

=������>���

=�������0��

���������

>��@�����	����(������������		���J

#���%����=�

#$#F.�.�.�=�����

#�$��=���������=��\�

��*�.�������������0��������

/:�>���������=�

7������������0����������������������0���	������1�6����;�����@��
��0���	���������	���?����������0��������������	��������
����@������������������ ����	����������������������������� ��
���������������1�=���������������������������	��������@���	����
������������������������0� ��	����	������������������������
�����������������	1�6����;�����@������I���������������
��������������I����/I&N�����(��@����� 3��/�I������@
 3��/�������	�����������	�I���������������������������1

Files used by STANEDIT

=��>.37�����������������������J

+�:
�:
�	���-J�����������������=��>.37���������������������
���������������	���	���������0���������	���������
���	��	�"�����������1

+��**����	���-J�����������	������������=�77���;���������������
��������������������������	��	���;���	����@�������>�����	1�7�
������������	������������������������	����	@��������������
��������������@���	�����1��������������C����	������(��0�������
=��>.37�1�7����������������	��������������������	���
=��>.37�@���������������������	���������������	�����1
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+*�
�7�F�,����
����,-J�������������0�	��������0�	����������
��������01���������������������������0���������������1�6��
�;�����@������������������		�����������0@�����������������0@��
�������������0@���	�����1�3���������������0�	��������������
���(�	�	����������0���@� �������������0���	��0����
	���������@�������	�	@������������������������1

+������	���
����
�E��-J�������������������� ���������=��>.37�
����	�����0���	������0���0���	��������0�������������������1
.;���������������0���	����������������0���D=�@��)@�48E@����
	���������D>@�>�@�=E@�������D%&@�3&E@���	�����1����
��������������� ����������(�	�����	��	��  ��(���������������
��0���	1�3���������������������� ����������(�	�	@� ����������
�����		��		��������������������	��0������� �����	����	1������
�������������� �������������������������J��������		��@
�����@�����@���	�����1

+��

���
�E��-J��������������� ���	��������������� 0������
=��>.37���������������������������	1��������������������
�� �����������������J��		��@������@�����@���	�����1������@
	�������������������(�	�	1�����������0���	��0������������
��C����	1

Summary

&���� ���������������������=��>.37�����������������	����
���������(������������������������������������������������	@���	
����������������=��>.37�����������������	��������������0
H������	�	I�D������������0� �������������;��������������
�����	E1��������������0���������������	���������������������
������������������������������������0����	��	�"�	���	
�������	��������	�(�	��������	1

Getting started quickly

3���������������������������������	��������0�����������
=��>.37�@��������������������������������������

����	�����01��������������0�����@�������0�����(��������
������"�	���������J

���������	��0������=�77����������������������	�����������
������1

���������	��"�����*+����������1

�������������=��>.37��������	�����������������������	� �J

&.�'&3��*+

�,-.��=�77

7>�.&���7).

3.45�

=��>3�&37A.��9�		�

'5�678.��9�		�1���

����4����������������	�������51=1��������		�������
��"#=�!�����
1

6�����0@����������������� �(����������������������������	�����
���������	�:�����8�
�1��������������	� ���������	����������;�
�	����@�������>�����	1������������	�������������������
=��>.37�����		�	@��������������������������������	����0��
�7>=��>����	�����������������������������	���������1
������	��������0� ��������	���������������������1����;������1
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Input file format specifications

Running STANEDIT

7����������0����	������ ������������������������������������ �
���	��	�"�	� 0�=��>.37��������������������������
	����	1�����������������	� 0�����������������	�����1����
��������� ���������	�����������������=��>.37�1�7���������	��	
�=�77��������������� ��������	���	����������	��������0����	��	
��;���	�����D�����;�����@�>�����	E1��������=��>.37�@������0
�����0�����������������������	�����J

-���������������	�����������>�����	J

�	��� ���1��

.�������������	�����������������=��>.37�����	��J

.�����������	����������J����1��

7������� �(���;�����@�����������	�������������	����1��@� ��
��0���������� ����	1

Preparing a STANEDIT command file

����=��>.37��������	�������������������� ������������	
�����������1�.����������	������������������	� 0�"������
�������������1���������������������	����������������� 0����
������������1�'��0�����������	������������������	1��������
��0� ��������	���0��������������������������1�6����;�����J

N�����������������

&.�'&3��*+���N���������������	������������������

��������������	�������C����	������(��0����@����������������
��������1��������������������	���(��	�������(�������������
����	��������������	�������������1�����������������
�����������	����������	�����@� �����0����	�������;�����	
������������������������������������	�������(����1

������	����������������	������������1�����������������
���������@�����������	�����	� ����	�	����������	����������	
�������������1

Output file name specification (OUTFILE)

�������������������������������������������������	��	�"���@������
������������������ ����������������������������	� 0�����������
���1�'5�678.������������������������������������������������
��� ��������	1������������������	�������	��������;������	�����	
��	�������	��������������;���	����(����01�����'5�678.
������������������������������������J

'5�678.�P������F����F����Q

������P������F����F����Q������������������������������1

'5�678.��������1�	

'5�678.��JZ���Z�������1�	

���'5�678.�������	�����C����	�����������������=��>.37�1
�����@�	��(����	��������������������0� �������	�	��������������
����1

Specification of record size (RECORD)

����&.�'&3�������	�����	���������0������"���������������	
��� ��������	1�����������	�����C����	�������������1�7�
(���� ����"�������	�����������@�����������	�����	������0
�����"���������������������	1�3�����������	��������������F������
��	�����F���	�����������������������	��"�1�7��������������������
���������������	@������"������	������0������������������������
�����	�D��������E@��;���	����������������F�����������F���	����������
���������������������1�����&.�'&3�������	�����������������
������J

&.�'&3�P�����	F�"�Q

������P�����	F�"�Q��������"��������������	�������������1
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6����;�����@�&.�'&3��$$���	��������������������������	���� �
������	����$$���������������1

����������������	��������0� ���������	���#@$������������1
���)���������������������	��"����� ���*+����������1

File type specification (TYPE)

�����,-.�������	�����	���������0�������0������������� ����
������	1������,-.���������������������������������J

�,-. �=�77

5>7R

47>�&,

�=�77@�5>7R@�����47>�&,����� �������1

�=�77J������	��	�-����;������1�7��������������� ��������	��������0
��������,-.������-&7>����������@�������������� �����	�������
���	��	���;���	����@���������������=�77�����1�=�����������(�
��������F���������	�����F���	��������������������	�������������1

5>7RJ���5>7R���;�������������0�������F���	���������������������
����1�7��������	�����0��	������-�@�������;�������������������������0
�����2������	1

47>�&,J���47>�&,�����������������;�	�������������	��������
��������F��������������F���	���������� ������������	1�7��������	
����0��	������-�@���������������������������������;�1�47>�&,
�������0��������� ����0�(�����D�������������������������
��� ��@������;�����E1�=��>.37����C�������������	���� �
������	���� ������=�77��������������1

7�������,-.�������	��������@��=�77�������	����-�
��������������@���	�5>7R�������	����5>7R��������1�7�
�=�77����������	����5>7R��������@������5>7R���������
����	1

���)��������������0������=�771

Interactive processing (INTERACTIVE)

����7>�.&���7).�������	���	��������������������������������1
��������C����	�������=��>.37������	�������������
���������(�������@���������������	���������� �����	�	������0� 0
���������C�����������	����������1������������������	� �
��	�������������������������������������=��>.37�1

Debugging patterns (DEBUG)

����3.45�������������0� �������	�	�����������������������
�����������������������������������������1�7������������ ���
�������������������������	���	������	���������(�	�������
��������0���������	�����������	��	�������1

����'5�678.����������������������������������	��	�"���������
������������������ ����������������������������	� 0�����������
���1�����;���������������������������	� ��������9�		�������
�J

&.�'&3��*+

�,-.��=�77

3.45�

7>�.&���7).

=��>3�&37A.��F�		�

'5�678.��9�		�1���

'�����������������	��0�������������(�� ����	�����	@��������
���������0�����������������	����	���	�������0�����
���������������������	����������������1�����������������	
��������������������=��>3�&37A.��������	1�����
������	�����	�	������0������������������	�	���� �	�������
���(����������1�����=��>3�&37A.�������	���(�����
����������������J

=��>3�&37A.�P�����F����Q
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���������F��������������������������0�	��������0@
��������������� ��@���	�����������������������������������	����
���������0�����������1

Address components

���������		���������������������;�����������	�(�	��������1
6����������@��������������0������������������	�(�����������
������1�����	�����������		������	��	�"������ �����������
	����������������������������������		�����	����� ���
�������1�����(��@�0������������ ��������=��>.37����������F
 ��	�0���@�����������������������������	@�����	������������
���������@���	�����������������������0���	��������� �
��	����	� 0��������1�=������	���������������������������
���������������		������	��������	����������������� ������
��������������������������������������������������1

����	�������������������������������		����� ���	
�����	�5����	�=������		����0��1�����(��@������������������
��������	������������������������������;����������������
 ��������������������� �������������1������	�����	������
�������������������������������	�����	��������������������
�������	��	�"��1
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House address components
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6������������������51=1������4�������7�.&�����@����������
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8.6�@�6&'%�&7���@��'�8.6�@���	��'�&7�����		��������
������������1�=�������������������	0�������	��	�"�	�����@�����
����������0�����������������������1�������������������������
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Street components
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Rural addresses
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Place components
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Standardizing addresses (MTCHADDR)
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Specifying parsing parameters (SEPLIST and
STRIPLIST)
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������	���	�����	��������������������1�6����;�����@������	����
������	���������������������	���������0���(����;���	1����@
>1�1���	�>������ ��������	���	���� ���������������	�>�1
�0����������������	���	���������	���	����	���
������(�1�6����;�����@�#��F�*+������������	�D�����EJ�#��@����
�0�����DFE@���	��*+1

=��������� ����������	���	��������������1�6����;�����@�#��
%����=���������������J�#��@�%���@���	�=�1

,��������(����	������	���������������� 0������0�����
=.-87=����	���=�&7-87=�1���0������������������=�&7-87=���
����(�	�����������(����;���	1���0������������������=.-87=���
��	�����������������1���0��������������������� ������������
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�����@����������	�����������������	1
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Introduction to match keys
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����� ������������������������2������	1�6���	�(����� �������������
����� ���������	����	������������� �����������������������F
��������������	1�6����;�����@�������������������	�������������
�����������������	��J

%�7>

��.&&,��788

The match key
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  �>3

 #���

#��&3

>����������������F	�������� ���������	����	���������@����F
	�������� ���������	����	���������@���	������F	�������� ��
��	������ ���������������	����	1������������� ��������������
������	��1��>3������	��#���1�����51=1�-�����=��(����������
�0����������	�����������������������A7-G������1

��������	�������	�����������	��������������������1

�����������������	�����������(������	��������1������������	�	
����������� ����0�������������������(������������� ���01�,�������	
2�����	�����R���������������	1

'������������������0������������������1�6����;�����J

�> > : R�N��������� ��

=> %> �* R�N�=����������

%) �% + R�N�%���������(����

�� � �$ R�N����0�����

������������0�	���������������	1�7�������������;�	������	
�!���������������1�7�������������������� �������	@��	�������	� 0
�����  ��(��������>N������������������	@�=>N�������������(����
����	@�%)N���	������0�����	@���1������������� ������������@����
���������������;�	F����@���������������(���������;�	@���	����
���0�����������������1�>����������������(�����������	�DRE1

���������������������������0�	��������0�����	� ���������������J

Z6'&%��Z�='&�L>

������������(���������� �������� ���������	��������	��	��������1
��������	����������������0������ ���������������	�����������0����
	�����	��������	��������01����������?�� ����0��������������	���
��������1

��������������� ��������������������������0�	��������������
�����������������	����������0���1

Name match key

����>�%.���������������	��������������������	������������
��0J

Z6'&%��Z�='&�L>

N

N�>������������0�	��������0

N

�8 � � R�N��������D%�1@�%�1@�3�1@����1E

6> � #+ R�N��6��������

%> �� #+ R�N�%�		�������

8> � #+ R�N�8�������

&
 � � R�N��&����Dc�1@�=�1@���	�����E

R> �� � R�N��=���	�;������������

��������������	�����	� ����(�	����������������0@�����	������
�����������;�����J

%&1�c'�>����&8.=���'%�=@�c&1

�8�L�%&

6>�L�c'�>

%>�L����&8.=

8>�L���'%�=

&
�L�c&

R>�L��*�$
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=���	�;������������������	�������������������	������	
���������	�������������������1�6����;�����@��'%�=@
��'%7=@���	��'%=@�����	�������(����=���	�;���	������*�$1

,�����0����������0������������	�������������	�	1�7�������
�������������	��D��������	��		�	@�����	�����	�����	@���	��
��E�0��������������������������������������������������1
&���� ���������������F��������������	���������� �����C��
���������������1

Place match key

����-8��.���������������	��������������������	������������
��0J

Z6'&%��Z�='&�L>

N

N�-�������������0�	��������0

N

����������*���R�N����0�����

R�������������R�N�=���	�;�������0�����

=�������������R�N�=������  ��(������

A-����>���*���R�N�A7-���	�

A�����>�������R�N�A7-G���		F�����	�

����������  ��(����������������F�������������	��	�5=-=���	�
�����������������1���������������A7-���	������	@����������
 ��������������A7-G����	�1�7�����������������F	������		F�����	�@
�������������	������ �� ����1

����	������������������;������������	��	�"�	������������������J

4.&
.8.,�=-&7>�=@��)��#���*F+:!/

���L�4.&
.8.,�=-&7>�=

R��L�4+��

=��L��)

A-�L�#���*

A��L�+:!/

,������������������	�������@��;�������������=���	�;�����	���	
����������  ��(������1�7������������  ��(������������������	�
����	�����	��������@����������������������������� ����	��������
������������1

Street address match key

����%����33&���������������	��������������������	������
��������0J

Z6'&%��Z�='&�L>

N

N��=�������		�����������0

N

�>�> ! R�N������>�� ��

��> ! R�N�����	�������������� ��

�=� � R�N������>�� ���=����;��H�I@�H#<�I@���	�����

-3� � R�N�-��	��������

-� � � R�N�-���0��

=>� �!�R�N�=������>���

=� � � R�N�=����;��0��

=3� � R�N�=����;�	��������

5�� � R�N�%����������0��

5)� #$�R�N�%���������(����

R=� � R�N�=���	�;����=������>���

R&� � R�N�&�(����=���	�;��������������
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����	��������;�������������		��J

#���F$��#<��>'&����.3�&�
>'88=�8>�.�=�@�=57�.�*+$F�

�>�L�#���

���L�$�

�=�L�#<�

-3�L�>

-��L

=>�L��.3�&�
>'88=

=��L�8>

=3�L�.

5��L�=�.

5)�L�*+$F�

R=�L���+$

R&�L�=�*�

,�����0������������	��������D�;���������=���	�;�����	E��
	����	1�����(��@�	����������	��		��������	��������C�����������
�������������������1

������(����=���	�;���	������	����������������		�����������1
7������=���	�;���	�������������������������	� ������	1����@
��������=���	�;���	������	�(�����	������.�����J 3���
��	����3 J�����.1

7������	� �����������������	�����������������(���������������
��������	��	�"��������������C���������������0�	���������@��
��������������� ��@���	���������������1�������;���������	���� �
������������������� ��1
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Classification table format

������������������� ����������	��	��=�77�����������������������
����01�������������������������������DNE1�.��������0��������
������0���	@��������	��	�"�	��  ��(������@�������0���	����@
��	�������������������������������	1

����	������������������;������������������������ ���������J

= = 3

=' = 3

�.=� � 3

�=� � 3

� � 3

.�=� . 3

. . 3

>'&���.=� >� 3 !$$1$

>� >� 3

&'5�. &� � !$$1$

&�. &� �

���������������������������������(�����	�����������	����
�������0��������1��������������0������������������������	�����	
 �������	������������������1���������	�����0����������	��	
�  ��(����������������	� ����	������������0���	�������������
��01�6����;�����@������	�����������������������	�	��
�.=�@��=�@�����@��������	��	��  ��(�����������	�����0� �
�1�����������	�������������������������������	����������������01
��������	�����0��������������������������������������	� �
�����	�����������	1��������������� �������	� 0����
������������������������ ��1�6����;�����@���������3���
�����	������	������	�����������	�������������������	���
��	�������������0��1����@�����(������������=����@����@

>����.��@���	���������������	����������3������	����������
���0�����	��������1�����������������	�����������������������
�����0�������������������� ����	�������������������������������
�		��1

�������	��	�"�	��  ��(���������������	�����*�������������
������1�������0���	����� �������������	1�%����������
�������	����	���������	���	������������0���	1

Threshold weights

���������������� ������������	�������������0�����������
�������	���������������0�����	�������������������0���������� �
��������	�������������������������0���	1���������������F���������
���������������������	������������������������������������
�����N����	�����������@�	�������@���	�������������������������N
��	�������������������������1�������������������	� 0����
�����������������	@����������������������������	�������
����������������������������	1�7������@������������	�����	
 ��������	�������������	��������������������0�������� �
��������	1��������������������������������0���������J

/$$J��;���������

!$$J�������������������������0��������

:*$J�������������� � �0��������

:$$J�������������� � �0�	��������

8�������� �����������������	���������� ����������������1

Special classes

,��������������0���������������������	����	��������0���	1
�����������0� ������������A1��������������D$E����(���� �����
��	�������������D�������E����	1�>�������	����������	�������
����������������������1�6����;�����J

'6 $ $

The classification table
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�������	��	��  ��(����������� ����0�(�����	����	�����������
����������������� ����	1

Address classification tables

.������������C���������������������� ��1�.������ ����������
�������	��������������1�7��	���?������������������		���@
����@���������@�������������� �����������	1�.�������
��C���������������������� ��1�����������	�������������� ��
��	����������	���	�����������������������������1�����(��@
����������������	���� ��������������	���������������������
�� ���������	�����������������1

����������������������������0���������	J

3 3�������� .��@����@�=�������

� =�������0�� �(����@�=�����@�-����

% %�������� ���@�\@�=����@�&���

4 4�; -1'1�4�;

$ >��� '�@����@����

R 3��������� 8��

' '�	���� =.�'>3@���7&3

� ���	���� =7R�..>@���&..

> >�� �� 676�,@��=7R�,

= =����� 8�

W -��

& '�����

�������������������� �����C����������;���������1�'�	����
��� ���������(������������'1����	�������� ���������(����
��������1�����(��@� ���������������$@�������� ����$@��$@��$@
��	���������������;����	������������ ����	�����D�����0F����E���
���	�����D�����0E1����������@����0�������(�����������>���

	�����������������1���������=�����	�������	������
=��������������8�@�����������������  ��(�����������8�>.1����@
8���7.>.������������������0����������	� 0������������	@� ����
����������������1�6�����0@����������W���	�&�������	��������
������� �;�������������������������  ��(�������-�'�4'R����
��	1�4����-���	�'��������� ���������������������0����	
�����1

Place classification table

���������������������������������	���������������������������
�� ��J

� =���� %��0���	@��0�����

' -����; >��@�>����@�=����

C =����; 7���	�D���&��	��7���	E

Reclassification of tokens

7�����������������������������������������������	@���������
����������������(�����������������	1����������������������	
�����	�������������������������� �������������#1�-�����#���0
����������������������� 0����0�������������������D$E1�-�����������
�����(�������������� ��������������#���	�������������0���
�����	�������������������������� ��������������1

��������������������������;�����������������������������	����
�������1�6����;�����@��������������������������	����;�������
�������		������������������������������	@����������-8��.
����������	�������������������0@�����@���	�A7-������������@
���(���������������		�����������������������%����33&
�����1

�����0����������	����	���0������������������ ��1����
����������������������������0���������������������	������������
��	��(��� 0�	������������������������������������������������
�����������������1
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���������������������������������� 0��������������	��	�"�������
����������	1�������2������������=��>.37�������������
� ����0���������������������	����;� �������1����������	�;
���������������	��������������������������������������������	
��������������������������������C����	����� ������������
���	��	�"��������������������1
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Pattern matching

7���������������������		�����������C���0��	�������	� 0
��0���	@�������		������	��	�"����������	� ����01�6��
�;�����@�#���>�%����=����� (����0���0���	������ 2���������0
�� �����01�������������������������������� ��1��������������	
 0���	��������@����C���0��	�������	� 0�������0���	�>@��������	� 0
��������������	�%�7>@��������	� 0����������0��@�=�1�%��
�		�������������������������������������(��������J

#���.�%������(

��*+�>�������0������&��	

#���=�����.���-����

������		����������������������������J

>������

3��������

5����������	�������	

=�������0��

���������������������	� ������������	��������������� �����	
��(�	���������������� �������	����������������0�U�>V1����
	�������������	� ����(�	�����������	�������������	�U-3V@����
��������������	�����	� ����(�	�������������������U=>V
����	@���	������������0�������	� ����(�	��������U=�V�����	1
>������������������������������������������	������	�����	�������
��������0�	��������01����� �������	�����������������������������
����������0�����	1���(��������������@��������������������J

>������J�U�>V

3��������J�U-3V

5����������	�������	J�U=>V

=�������0��J�U=�V

Tokenization and classification

=���	��	�"������ ����� 0������������������������������������
�		�������������1�.������������������������	��������� ��@�����
��;�����������@��������	� 0�����������������1����������������
�������������������	@���������������������	� 0�����������������
��������������������������� ��1�7������@��������(����������
��	�����	� 0������� ��1�7�������?�@���?���(�����������������������
����J

^J�>������

�J�'�������������������(�������������������	

QJ�8��	�����������

PJ�8��	��������� ����

`J�������;���;�	

fJ�=������

$J�>���

FJ��0����

<J�=���

]J��������	

\J�>�� ������

DJ�8�������������

EJ�&��������������

����������������������������	����@������;�����@�#���1

������������������������������������������������	@����
�;�����@������0�����1

�����	����������������������� ����������	� 0������������
������@������;�����@�#���1

�����	��������� ���������������������������	� 0������������
��� ��@������;�����@���1

The pattern rules
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��������;���;�	�������������;����������������	��������������	�
������������������ �(������@������;�����@�#����*@��4���*�&1

�������������������������������������������������������������0
����������	�����		���1�����������	��d@�`@�f@�b@���	�����1

�����������������0����	����������� ������	���	�����1�����
���	���0������������������������������ �����	�������(������0��
���"���1�=�������0@���������������(��������������������������
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Patterns and actions
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�����������DNE���������	���	���� ���������1������������������0
 ����������������� 0������0����������������������������� ����
���������1�6����;�����J

N

N�������������	��	��		����������

N

^�_���_����N�#���%����=�

��������������������������������������@�����	���������������
������������=���	�;���	�������������������	���������
��������������	��J

#���>�%����=�

#���%����=�

Z-'=�9=��&�

='5>3.R�U=>V��UR=V

Z-'=�9.>3

^�_�3�_���_�� N�#���>�%����=�

�'-,�S#T�U�>V N����0��������� ���D#��E
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Pattern format summary
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Simple pattern classes
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Unconditional patterns
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End of field specifier ($)

����a����������	��������������0���������0�����������@� ��
����������������	������������	1�7����������������������������



116 GEOCODING RULE BASE DEVELOPER GUIDE

�������������	F��F����	�������1�����a���������������������1�3�
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Subfield classes (1 to 9, -1 to -9)
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������J�����G�����	�����������������	���.&&,1��������(�����
�������788�=�>3=��������������1�����F#�����	���������
=�>3=1����@�������	�S#T�����.&&,���	�������	�S�T��
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Subfield ranges (beg:end)
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�������������������	����� �����������	1�,����������
�����0�����������������������	1��������������D ��J��	E1�6��
�;�����J

D#J�E������������	�#�������������������������1

DF�JF#E�����������������	����������������������������	������
�������������1

D#JF#E����������������������������	�D�����������������������E1

=�@���������		���#���F���4�%����=�@������������J

^�_�F�_�D#J�E

�'-,�S�T�U�=V

&.�,-.�S�T�$

����������4� �������(�	��������U�=V���������0�����	1

Universal class (**)

��������DYYE�����������������1�6����;�����@��������������YY
����	�������#���%�7>�=�@���	����������������#���%�7>�=�@
8'=��>�.8.=@����/$$#+@���	�����1

�������(������������� ����� ���	������������������	���
���������������������  �	� 0��������1

6����;�����@�YY�_����������������������� �����������0��@������
��0� ����������@�����������0��1����@�#���>�%����=������	

�����������������	�S#T� �����#���>�%������	�������	�S�T� ����
=�1

7������������������������������������������C����	���������	�����
�0��1����@��(������������������������������@������������	�S#T
 ���������1

7������������������^�_�YY�_��@�����YY�������������������� ������
��������������	������0��1

�������������������0� ���������	�������YY�������	1�6����;�����@
^�_�YY�D#J�E�_�������������������@��������	� 0������������
��������F�0��������@��������	� 0����������0��1�'�����	�S�T
����	�����������;����0�������������F�0��������1�����������
#��������0������=�@� �������#���%����=�@���������0����������
�������������� ��1�&����@�������D#J#E�����������0������������
��	�D#JF#E����������������������������������@�������������	1
����(��@�����������������YYD#J#E��������������������
������������������������C��(������]���������������0������
�����1

>�����	��������(���������;�������������������	�����������	
�����YY1

Floating positioning specifier (*)

7��������������	����	��������������������@���������������	���
��������������������������������	1�6����;�����@���_�������	������
%�7>�=����	���.&&,��788�&3@� �������	�?��������#���%�7>
=������������ �������������������1

-�������������������������	������	��0����������������������
����������������1�6�����������������������	�����������������
����	�������������������������1������������DYE�����	������	�����
�����������������	�����0���������������������������1�=�����
0��������	���������������������������� ��@���������@�����
���0�������������1�&��0������������������������������	������
�����������		�������������������������(����������������
��� ���������������1
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�		����������#���%����=������������#���\�*�%����=�������
���������������Y�%�_�^1�����Y�%�����������;�����������������
����������������������������������	1�>����������������������%�_�^
����	��������������������������������������������� ��1����
���������	���������������������������� �������	�������	��������
����%��������������	� 0�����������������	1��������������
����������	������������ ����	����������������������������
��� ��������������J

Y%�_�̂

�'-,9��S#T�U5�V

�'-,�S�T�U5)V

&.�,-.�S#T�$

&.�,-.�S�T�$

&��0��������������	�����������������0�����(�����������
����	�������� 0���0�����������������������������	���������������
�������1

6�����������������������������(��	�������� ���������(������
����������������� �������������� ������1�6����;�����@��������
�����������������0�������	����	���	�(�	������������������	��
���� �����J

#���%����=������*

#���>�%����=������*

#���>�%��������*

���������������������@��������������		�������� ��������	
�����������������������Y�%�_�^1

6������������������������������������ 0�������������������
��������������������������	1�6����;�����@��� #���>�%��������*@
����#���������	1���������������������Y�%1����������>�������	1
����������������1����������������	1����������������%1����
��������������������������	������������������	1�7������������	

�������������0@�������������������@� ���������@�������������
�	(����	�������������	��������������������	1����������������
��(�����������������������������������1�7�������������������@
������������	���N���������@�����������������	(����	�������
��;�����	1�>����������������������0� ���������������������������
��������������1����������������������������	@���������������
������;���������@��(������������������0� ���������������������
����1

��������������� ���������	� 0������1�6����;�����@�Y�%@�Y��@
��	�Y�^���������(���	�������	������������������������������������
�������	� 0������	��	����1

��������0� �������������������������������������������������
�������1�6����;�����@�Y^�_���_�Y����������������c'�>�3'.�#��
��.&&,��788�>'&���&31�'�����	�S#T���#��1�'�����	�S�T��
��.&&,��7881�'�����	�S�T���&31

Reverse floating positioning specifier (#)

������(��������������������������������@�������	� 0������ ��
����D\E@����������������������������������������������DYE��;����
�������������������	�������������������������	����������������
�����1���������������������(������������������	��������������
��	����������	@���������A7-���	�@����������@����������
	���������@���	�����1

������(����������������������������������������0��������������
�����������	�������������@�������������	�����������������������1

=������0�������������	���A7-���	�1��������������������
�������(�������=1������������J

K�����

����	�����������������������������������������������	� 0��
��� ��1���������	���������������������������J

������������*�-��	���@�-�����;����"����#���*�3�����*
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���������F��F�����������������������������������"���1����
��� ����������������������������������������1�7�������������
����	@�������������	������������������������������������������	
 0������ ����������	1�7��0��������������	�����������	��	�����F
�����������������������������������DY=�_�̂ E@����������������������*
����	� ������������0�����������	�����������������	�A7-���	�1

Fixed position specifier (%)

=�������������������0�������������������������������������
�����������������	�������������������1����������	��	� 0�����b�
��;�	�����������������J

b#J�������������������������

b�J�������������������	������

bF#J������������������������

bF�J�������������������	���������������

���������������� ��C�������	� 0���������������b��������������
�0��J

b�^J�������������������	��������������

bF#^J��������������������������������

b��J�������������������	��0��������

b��J�������������������	����������	���������������
��������������� ������������������

������;�	������������������DbE������0���������	�����������
������	�������������@�������������	�����������������������1����
��;�	�������������������������������	�����������0��1�6��
�;�����@�����	�����������������	J

c����3���#���%������8������=��=����8���1

b���������������������	������������������(�����������	
D%������8�����E

bF#�������������������������������������(�����������	�D=���
8���E

b#�#�������������������������@���������	�Dc���E

b#���������������������������@�����	����	�D3��E

b��#J�������������������	���������������	�D%�����E

bF��F#J�����������������;��������������@��������	�D8�����E

b�GJ�������������������	����������������	�D%�����E

bF#GJ����������������������������������	�D8���E

���������������������	������������������������������������
��������������D�������Y���	�\E1

���@�����������������b�^�_�3�����	�����������:!/�=�������
����� #������*+�4�:!/�=� �������	�����������#������*+�4�:!/��
#���=1������� ��������������	���� ���D:!/E��������������	� 0��
	��������1

Negation class qualifier (!)

�����;����������������DdE�����	������	������>'�1����@�d������
�����0�����	�����������������0��������;��������������0��1�d�
������������0�����������������������1�6����;�����@�Y�%�_�d�
����������=57�.���@��-���&'5>3@� ����������=57�.�=�&..�1

���������;��������������������������C�����������������0������
�������	���&��#������ ��������������������0��������������
�����������	�����������D������&��#���%�7>�=�E1

����������������Y��_�^�_�d������������&��#��� ����������&��#��
%�7>�=�@������������������������������������������������	1

�������������������0� ����� ���	�����������������������DYE
���0�������� ���������������������1�6����;�����@��������������
�������		���@�0������������������0��;���	�=�����=�7>�
����������������1����@�=�����&8.=�=������	� ��������	���
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=�7>�����&8.=�=�@� ���%�7>�=��&.�&��-������	����� �
������	����%�7>�=�7>��&.�&��-�1������������<���������J

Yd��_���L�L�H=�I�_�G

&.�,-.�S�T���H=�7>�I

�������������������@�����������C��������������������������	�
����(�����=�1
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��	�������������0�������������		������	��	�"������������
��� ����0��������������	�������������������������1�6����;�����@�=�
���&8.=���	��).>5.�'6���.��%.&7��=� ���������������_��@
����� ����=����	��).>5.������������0��1�����(��@������������
���@�����=�����������=�7>�@���	������������	������).>5.��
�����������0��1��������������C����	���� ������������	��������1

����	��������������J

#���.�=���.=���7����,���	

#����.=��='5���=�&..�

7��������������@�������������������������.�=���.=�@���	�������
����	�����������������������������='5��1����0� ���������
����������������Y�3�_�3�_��@� ����������C�����	���������������1

-��(�	�������	��������(����������������������������0������
������� �������1

Simple conditional values

�����������	���������;����	� 0������������������������	
�������	� 0�����C����������	���(����1������ �����(��������� �
���	�� ���C����1������	���������	���������=�1����&8.=�����
�������������0�������	� ��Y��L�H=�I�_�G1����������������0��
�����(�������=���������	� 0����������������� ����1����
����� �����������������0������=������	������������������@
�������=������=�7>������	������	������������1����������
����������	��������������	���=������	� �J

Y��L�H=�I�_�G

&.�,-.�S#T���H=�7>�I

����&.�,-.�������������������	���������G@������G��������
���	���������������0��1�&�����@�����������������������������0��
�C��������1�7����G�����	�����&.�,-.���������@�����@������0
�(���@����������0��������	� 0��1

����(�������� ���������	��� ��	���� �����������	��	
�  ��(�������D��������;��E���	�����������������	1��������(���
0����������(���������	��������� ���(����@������=����	
=�&..������	� ��������������������	��	�"�	��  ��(�������=�1

=�������������	�='5���������������������������� ��1�7�����
���@�0�������	������;�������0�����='5��� 0���	���J

3�L�H='5��I

,�������	���������������0�	���������������������	��	
�  ��(�������=� 0���	���J

3�L�H=I

��������������	1

>�������(�����������	�	���������C����1�6����;�����@�Y�̂ �L�#$$$
_�������	����������#$$$�%�7>� ����������#$$#�%�7>1

�����C�����0����������DLE����� �����������	��	�"�	
�  ��(���������	��������������������(����������C�����0�������
������	1������		����������������������(���� �������������
�C�����0���������  ��(����������0�����������������������(��������01
���������L�L���	�L�L1�L�L����������  ��(����������0@������
L�L����0������������������������(����1

6����;�����@�0�������	�?��������������	��=�1����&8.=��
=�&..�����&8.=@�������������������	��	��  ��(���������
=�@��������������� ���������������C�����0������������������������
(����J

Y��L�L�H=�I�_�G

&.�,-.�S#T���H=�7>�I

������������������=������������0���	�	���	������������
(��������������������������  ��(������1�=�������0@����L�L�����
����������0������  ��(���������	����	1�6����;�����@�0�������	
���L�L�������J

3�L�L�H.I

Conditional patterns
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7���������@����	���?����������������������������	����.�=�����.1

Series of conditional values

�������������	��������(��������������	� 0�	�������������
�������������� 0��������������1�6����;�����J

��L�H=�I�@�H�)I@�H-8I���

��L�H=�I�H�)I�H-8I

�����C��(��������	���������������0�����������	��	�"�	
�  ��(���������=�@��)@����-81�>���������������� �����������	���
��������������@��;�������������C�������������1

�����@������  ��(��������C�����0����������L�L����������������
(��������������L�L���0� ����	J

��L�L�H=�I@�H�)I@�H-8I

����������(��������� ������	��������������������0������������
������J

^�_���_�U=>V�L�H%�7>I@�H.8%I@�H�'88.�.I

7��������������������������0�(�����������	�D�����	������������
��������������	E@��������������������������������������	
D�����	������	F��F����	E1�6����;�����@���������������������(���	
�������������������	��������������������0����J

^�_�U=>V�L�H%�7>I@�H.8%I@�H�'88.�.I�_��

Tables of conditional values

7�������������0���������0������������ ���������	��������(����@
������� ������(�������0� ����	1��� ������� ���������	��
������J

`P�� ������������Q

������;�����@�������0��������	������������� ��������������
���������������������������	�1�,������������������������=�77

����������������������������������	�1�����������������@�����
���������������	������	�1	�����	��������������J

/$$#+

/$$��

/$$:�

/$$��

111

����������������������0@�����@���	�A7-����������������J

��_�=�_�^�L�`�����	�1	��

������������������������H8'=��>�.8.=���������I1�7�����
��������������	�������������@������������������������@���������
���	������1�H8'=��>�.8.=����/$$#+I�����	������@� ��
H��7���'�78�#���*I�����	��������������A7-���	��������������
�� ��1

������ ��������������0���������������������������(������
�����������1

%�������0��������� ������	���������� ������(����J

^�_���_�U=>V�L�̀ �������1	��

=�������������0�������������������������������	@��������
����������� ������(����������������������������������	@
�����	���������	F��F����	�������	1�6����;�����J

^�_�U=>V�L�̀ �������1	���_��

������(���	@����������������������	�������������� ������1

>������������(�������������� ����������������������@����0����	���
 �������������1
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Conditional expressions

7��������(���������� ������(��������������������������C�����0
����������������@���������	���������;���������0� ����	�	1
�������(����������������������J

P������	Q�S�P���	���������;�������Q�T

�������	���������;���������������	���� ���������	�����0
����������������������������	1������������	���������;������
������������������	@����������������������@���	�������	
������	1������������������������������������������J

P ������������������������

Q �����������������������������

L �  ��(����������������������������C������

L�L �  ��(����������C������

L�L ������������������C������

PL �����������������������������C������

QL ����������������������������������C������

dL �  ��(���������	�������������������������C������

dL�L�  ��(��������������C������

dL�L ����������������������C������

����������	����� ����0�����������������J

��(���� �������

������������0�������������������������������	

������������0���������������0�����	

���������

�� �������

�����������(���� ���8.>���	�-7��

������������������ ��	���� �	������������������������@������
������;�����1

Referencing current operand contents

�����������������	�UV���	��������������������������������
������	1�������������������������@�����	����������0@�����@���	
A7-���	���;�����������1�,��������������������������������0�����
���0���	�������������������	�����A7-���	�����������������*$$$$J

��_�=�_�̂ �SUV�Q�*$$$$T

����������������	���������J

��7���'�78�*$#$�

 �������	�������������J

�84�>,�>,�#���*

�����(���@�������������������	���(�����������������������J

'�����	�#J '����������������������	

'�����	��J ������=����	

'�����	��J ����������(������������������*$$$$1

����������������������������������C�����0����@��������	��	
�  ��(�������������	@�����������(���� ��1�7������������������@����
���������������������	1�6����;�����J

��S�UV�L�H=�I�T

�������������  ��(����������������������������	�D=�E�������
��������=�1

��S�UV�L�H=�&..�I�T

�������������������������������	��������������������D������������
�������������������  ��(������E1

��S�UV�L�L�H=�IT

�����������0������  ��(����������������������������	����=�1
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��S�UV�L�L�H=�&..�IT

���������������������(���������������������=�&..����	��������
�  ��(������1

���������������D����������������C�����0���������E����
�������	J

��S�UV�PL�H=�I�T

�����������������������	������������������  ��(������1�����������
������0������������������������(����1�7���������@����������������
(����������=����������������	� ������@� �������������������(����
�����=�&..���������������������	� ������1

Referencing match key contents

7�������������������������������(����������	����������������0
���������������������������������������X�������������������
���(����0��;�����	1��������� ������������	� 0������0�������
��������0�����	������������	���� ����1

6����;�����@�������0��������������������������������	
.�=���.=���7����,1�7��A7-���	���$#$$�����$�$$���������
���������������.�=���.=�@���	����A7-���	��!$$$$����/$$$$@����
����������������������.=����	�.�=��������	��������1�=�����
���������A7-���	������	����������������0���������	���� 0�����������
��������	�����	�UA-V1����������������������X�����������
����	� ����	J

^�_�3�L�H.I�_�3�L�H�I�_���L�H��,I�_�S�UA-V�QL��$#$$�]�UA-V
PL��$�$$�T

�'-,�S#T�U�>V��N���(���������� ������U�>V�����	

�'-,�S�T��������N��������.�=���.=����	���(���������������

�'>����S�T�����

�'-,������U=>V

�'-,9��S�T�U=�V��N���(����,�����������0�������	

^�_�3��L�H.I�_�3�L�H�I�_���L�H��,I�_�S�UA-V�QL�!$$$$�]�UA-V
PL�/$$$$�T

�'-,�S#T�U�>V��N���(���������� ������U�>V�����	

�'-,9��S�T�U-3V��N���(��.�=�����	��������

�'-,�S�T�U=>V��N���(���.=���������������

�'-,9��S�T�U=�V��N���(����,�����������0�������	

��������������������;���������0����������	1���������������	
����J

UA-V ����(������������A7-���	����������0�����	

QL �������������������C������

�$#$$ ������������(������$#$$

] ��	

UA-V ����(������������A7-���	����������0�����	

PL ��������������C������

�$�$$ ������������(������$�$$

���������������������]�������� ����	����	�0��@� ����������	
������������������	���������;������1�>������������������	�����
�������	��������������������	1�7������	����� �������	�������
������	�������,���������J

^�_�3�L�H.I�_�3�L�H�I�_���L�H��,I��S�UA-V�QL�!$$$$�]�UA-V�PL
/$$$$�T

�������������������	�������1�7��������(��@�������������	�������
���	���������������	��������������������������	@�������
����1
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��������	���������0�������������������0���������D��	�������0
��������������	E@����������� �(���;�����������UA-V@���������
���	�����������������������������������	1�6����;�����J

^�_�SUA-V�L�!$$$$T�_��

����(���	��������������	�������	�	�������������������������
����	@���	�������	�������	�D�E���������������	�����1���������	
 ���������	�����J

^�_���_�SUA-V�L�!$$$$

Referencing variables, literals, and constants

>����������������������������	� 0���	��������� ��1�6��
�;�����J

^�SUV�L�#$$$$T

������������������	���������������� ����C�������#$@$$$1

>�����(����� �����	�	�����������������������������	���
���������������1

8����������������������������1����0��������������	� 0
��������������������C����J

��S�UV�L�H%�7>I�T

��������������������;��%�7>1

7�������������������	�D�E����������	@������������������	����
�����������	���������������	1���������������.&&,��788@���	�

��S�UV�L�H��.&&,�788I�T

��������������0�(���������	�����	� 0�������������(��C����
����1

��S�UV�L�HIT

����������0������0�����������������������������������������
�����1�6����;�����J

��S�UV�Q�H%�I�T

�������������������������������������%������������1����������	�
%�@�%�7>@�>�>@�-��@� ��������3�%=@�%@�8A@���	�����1

&���� ���������C�����0�DLE�������	���������  ��(��������������
������	�����@���������;��@���������������������������������	1����
������������������������������������������������	���	��������
�  ��(������1

����������0�	������(���� ��1�)���� ������� ����(�����0�����
	����	1�)���� ���������������������(����� 0������������
������1�)���� ������� ������	�������������(�����������
���	�����1�)���� ������� ������	������	��������������������
���(������J��������������������� ������� ����@���	������������0
�����;���	�������������1��������������������������@���0
��� ����������������@�	����@������	�������������������0� �
��	1

6����;�����@�������0����������(���� ��������	���������A7-
��	�1�,������������������������������	����#���*���������J

S�����	��L�#���*T

�����0���������	���������� ��������������������������	���
��� ���	�����������	��	����1�6����;�����@������������
^�_�S�����	��L�#���*T���	�̂ �S�����	��L�#���*T����	�����	�������
�����1

7��������(���� ���������������������(����@�����0������������1�7����
������������������(����@�����0��������������1

7�������	���������0�����������(���� ��������������0�����	���	����
��������������������	@��������	���������������������������	1
6����;�����J

^�_�S�����	��L�#���*T�_��
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����(���	��������������	�������	�	�������������������������
����	���	�������	�������	�������1�7������	� ���������	�����J

^�_���_�S�����	��L�#���*T

Referencing the length of an operand

���������8.>�C������������(���� ��1���������������������������
���������	1������;����������� ����	�	��J

UV�8.> 8�����������������������	

P(���� ��Q�8.> 8��������������������(���� ��

UP�����F��0F����	QV�8.> 8�����������������0�����	

6����;�����@�������0���������������������������F	�����A7-���
���������#���*F+:!/1�,����������� �����������������(�F���	�����F
	�������� ��@��������(��01

^�S�UV�8.>�L�*T�_�F�_�̂ �SUV�8.>�L��T

7��������������	����������������������@���������������������
�����1

=�������0������������������������(���� ��@���������;������J

��S������8.>�L�*T

������������������(���� �������������(�����������1

6�����0@��������������������������������0@���	���������F���������
����	������������� ����J

S�U=>V�8.>�L��$�T

Referencing a template of an operand

���������������������������������������������� ������	1
����-7���D�������E�C������������(���� �������������������1
����	������������������	������������	�1����������������
��������������F��� ��F����������D����E���� ��F���������F

��� ��1�.;�����������	�J�
#�����1�����-7���C�������������	���
��������� ����� �C�����1

`�SUV�-7���L�H���IT�_�̀ �SUV�-7���L�H���IT

����̀ �������������������;��0��J���;�	�����������	������1����
��������	������������������������	�����������	���� ���	1����
��������������F��� ��F���������@���	�H���I��������� ��F
���������F��� ��1

>�;������	���4��������������	�����������������������F
���������F��� ���D����E���� ��F���������F���������@������
�4��*>�1

P�SUV�-7���L�H���IT�_�Q�SUV�-7���L�H���IT

����-7�������������������������������0�(����J

S�UA-V�-7���L�H���I�T

���(���� ���(���� ��

S������-7���L�H�����I�T

'��0������C�����0�DLE���	����C�����0�DdLE������������0� ����	
�����-7������������1

Referencing a substring of an operand

�������������������(�	�	��������������������������������������
������	1�����������������������	�� �����1��������������
���������(���	J

UV�D ��J��	E =� �����������������������	

P(���� ��Q�D ��J��	E =� ��������������������(���� ��

UP�����F��0F����	QV�D ��J��	E =� �����������������0�����	

����D ��J��	E������������� �����������	���	����������������
�;�����1�����������������������������������#@������������������
��F#@���	�����1
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6����;�����@���������0����		������(�������������0��
��	�����	���������������	�����������������1����@
�.==.=�&�==.�������.==.�=�&..�1������ ��������������
 ����	���������������������;�J

����	�������������		��������J

�.==.=�&�==.�#*

�����������J

G�SUV�DF:JF#E�L�H=�&�==.IT��_�̂

����	�����������������	���	�������=�&�==.������������������	
 0����������1

=�������0�(���� �����	���������0�����	����� ������	J

S�����D�J�E�L�H �	IT

SU=>VD#J�E�L�H6'&�IT

��������	�������� ������������������������(�����D�E@
����� �������������������������������(�	1����@�������
%�&�7>�85��.&�
7>�������0�H%�&�7>85��.&
7>�I1

Arithmetic expressions

������������;����������� �������	�	������������������	�����
���	���������;������1��������������������������������������
�(���� ��J

L �		�����

� � ��������

� ��������������

B 	�(����

M ��	���

�������������������	�����������������������;������1�>�
����������������������	1�������	�������������������

������	�����������������	�(����1�6����;�����@���M�#���$�������
��� �����	�(�� ��� 0����1�7����#����������� ������		1�������
�������������	������@�����������������������������	�������
�;����������� ���������	J

P����F������	Q�P����������F��������Q�P�����F������	Q

���������������	���0� �J

(���� �������

UV

UV�-7��

UV�8.>

UP��������0�����QV�-7��

UP��������0�����QV�8.>

(���� ��������-7��

(���� ��������8.>

UP��������0�����QV

P����������F�;������Q

����������������������������P@�Q@�PL@�QL@�dL@�L

����������������	���0� �J

(���� �������

�������

�������

���������������;��������

P����F�����F������	Q�P�����F��������Q�P�����F�����F������	Q

������F�����F������	����

(���� �������
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U�P��������0�����QV

UV

��������������������G�F�Y�<�b

�������F�����F������	���0� �

(���� �������

�������

.;���������������������;����������

�����F�� ����������������F��

UV�b�� ��������������	�(�������	�����

����	��������	���������;������������������������(��F��� ���	
����1

^�SUV�b���L�$T

.(������ �������	�(�� ��� 0��@����������������� �����	�����
��"���1

>����������������������������������������������	�������������������
���������D�����C�������E1

�����	���������;�����������	����������������������������	
	�(�	�	� 0�������������������������������������(���� �������J

^�SUV�<���Q�����T

����������������������������0�������������	����������������������
������������������������������������1�'������;������������	������
�;���������(��(������������������J

S������Y�������Q�������T

S�UA-V�G���Q�#���*T

Combining conditional expressions

���������	���������������	����������	���������;������
�����������������������	1����	���������;���������0� �
��� ���	� 0��������������������������J

] ��	

_ ��

������������(��F��� ���	�����������������������������	J

^�SUV�b���L�$�]�UV�Q�#$$$T

��������������������������������#@$$$����#$@$$$J

^�SUV�QL�#$$$�]�UV�PL�#$$$$T

������������������������#$$�����������������#@$$$J

^SUV�P�#$$�_�UV�Q�#$$$T

������������(��F��� ���	��������	�����(�������������	�(�	�	
 0����������������*$@������A7-���	���������������#���*J

^�SUV�b���L�$�]������<���Q�*$�]�UA-V�Q�#���*T

>������������������������������������	1������������������
�;�����	��������������1���������������� ������F	�������	����	�����@
�>3���	�'&����������������� ����;�	1�����������������
������	��������������������������	1�'�������������	��������� �
� �����	� 0����������������������������	������� ��1�6��
�;�����J

DD��_� E�]�D��_�	EE����� �����������	� 0J

S��_� T�_�S��_�	T

����(������������������������ �������������������'&����������@
��	����������	������ �����������������	���������1�7�����
�;�����@��@� @��@���	�	�������������	���������;������1
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�����(�������������������@��������������������	�����������
��������	1�����������������	����	����������0�����������(���
������1����������������������0��������	�������������
������1

&���� �������������������	��������������D�������	� 0����
(������������E�������������	���� ��1�6����;�����@���������������J

^�_��_���L�H=�I

����������������������	J�S#T@�S�T@���	�S�T1

Copying information (COPY)

�����'-,�������	�����	�������0����������������������������
��������1�7����������J

�'-,�P�����Q��P������Q

����P�����Q����� ����0�����������������J

������	 ����������������	�DS#T@�S�T@�111E

� ������ ������	 ��� ���������������������������	

��;�	�������	 ���	�������������������������� ��

����(���� �� �����F	�����	�(���� ��

��������0�����	 ����0�����������DU=>V@�111E

��������	�����	 ������������������DU�7�,V@
U=���.V@�111E

������� �������������������C�����DH=�7>�IE

������� ����������(����

����P������Q���0� �J

��������0�����	

����(���� ��

6���@�����	����(������������;�����1�����	��������	��	
�		��������������������	����������H#���>�%�7>�=�I1����
����	� �J

^�_�3�_���_��

������� ���D������	�S#TE�����	� ����(�	���������������� ��
U�>V�����	����������������0N���������3�������	�D	��������E
����	� ����(�	��������U-3V�D�����;�	��������E�����	�������������
��0N�������������������	�D����������E�����	� ����(�	�������
U=>V�����	���	������������0���D�����E�����	� ����(�	�������
U=�V�����	1�����������������	� 0����������������������X������
��J

^�_�3�_���_��

�'-,�S#T�U�>V

�'-,9��S�T�U-3V

�'-,�S�T�U=>V

�'-,9��S�T�U=�V

.R7�

�����'-,9��������	������������������'-,�������	@��;����
������������	��	�"�	��  ��(��������������	����������������0
��������������������(����������1����������'-,����������������	
D���������������������E���������0��������	���������������������
������������0�����	1��������	���������� �������������	���������1
=������0@����������'-,��������YY�������	���������0����������
������������������������YY1����0������ �������	��������
�����(������ ����1

��������������� ������������	��������(������������
�(���� �������������'-,�������	1

Actions
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Copying substrings

������������������������'-,�������	������0�������������	
�������������0�(����J

�'-,�S�T�U=>V

��� ������������������	����� �������	� 0����������� �����
������	�����1�����������J

�'-,�P�����QD J�E�P������Q

������ ������� �������������������������������	�����������	���
������1

6����;�����J

�'-,�S�TD#J#E��U=>V

�������������������������D#J#E����������	��������������������
��������0�����	1

�'-,�����D�J�E�U=>V

��������������	�������������������������������������������
����(���� ���������������U=>V�����	1

F#����� ����	������	�����������������������@�F��������;��������
���������@���	�����J

�'-,�S�TDF�JF#E�U=>V

���������������������������������������	��������������������
����	1

����� ������������	����0���������������	��	�������	���
����(���� ��1

 Copying leading/trailing characters

������������������ �����;�	�������	���������1���������J

D�E �������	���������������������

DF�E ������������������������������

D�E �������	��������� ��������������

DF�E ������������������ ��������������

������������������ ����	��������	��	�������	�����������
(���� ��1

����	�������		���������#����%�7>�=�1�,������������#�����
 ���������"�	��������������� �����	���������� ���������"�	��
���������� �������;1��������� ������������	���������J

Q�_���_��

�'-,�S#TD�E�U�>V

�'-,�S#TDF�E�U�=V

�'-,�S�T�U=>V

�'-,9��S�T�U=�V

.R7�

>��������������������������	�D-E�������������������������D���	���
�������E1���������	������	�����������������������	������
����0� ����	������-����+�������	1

Copying user variables

������(���� �����0� ���������������	<�������������������'-,1
�����0�������������������(���� �����	��������	� 0������0���������
�����1��6����;�����J

�'-,�S#T�����

�'-,�H=�7>�I�����

�'-,�����#������

�'-,�����#D#J�E������

��������������������������	�#������(���� �������	�����1����
����	������������������������H=�7>�I��������(���� �������1����
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����	���������������������������(���� �������#���������1����
��������������������������������������������������#���������1

5���(���� �����0����������#X���������������������������
����������������� �������	������������������������������@
��� ��@����������	����������������1

5���(���� �������������������	�����������'>�������������
�������������	1�6����;�����@����0����������������.�=���.=�
��,@��������������������������.�=���.=�@�������������������
����������	������������	��������������J

^�_�3�L�H.I�_�3�L�H�I�_��

�'-,�S#T�U�>V

�'-,�S�T�����

�'>����S�T�����

�'-,������U=>V

.R7�

��������������������������������	���������.���	��1����������
�������� ����������	@���������	�������	��������	�����������
(���� �������1�����������������������������.�=�1�>���������
�  ��(������������������	@� �����������������������1��'-,������
�������������������	��������@��������'-,9�����������
�  ��(������1�������;���������������������������	�	��������
�.=���������(���� �������1�����(���� ��������������
.�=��.=�1�6�����0������������������������������	�������������
���������	1

Copying match key fields and formatted fields

%�������0�����	����� �������	������������������0�����	J

�'-,�U�>V�U��V

����������	�����	��������� �������	��������������0�����	1�6��
�;�����@����������������������������������	��7�,@�=���.@

��	�-'=��8�'3.1���������������������������	�����	�����	����
 ����(�	�	������0������������������0�����	1�6����;�����@��������
������������J

=��>3�&37A.��7�,�D#X�$E

=��>3�&37A.�=���.�D�#X�#E

=��>3�&37A.�-'=��8�'3.�D�#X*#E

�'-,�������	����� ����	�������0���������	����������������	
���������������0�����	J

�'-,�U�7�,V�U��V

�'-,�U=���.V�U=�V

�'-,�U-'=��8�'3.V�UA-V

Copying standardized abbreviations (COPY_A)

�����'-,�������	���������������������	������������1����
�'-,9����������������������	��	�"�	��  ��(�������������
������	������������1�=���	��	�"�	��  ��(�������������	�	����
����������������������������� ����������������1����0��������
�(���� ��������������	����	�����@��������������@������
�������@���	�����1

�����'-,9������������� ����	�������0������  ��(������������
������	�����������������������0����������(���� ��J

^�_���_��

�'-,�S#T�U�>V

�'-,�S�T�U=>V

�'-,9��S�T�U=�V

��������	�����������������  ��(����������������	�������������
�������0�����������0�����	1�=�������0@

�'-,9��S�T�����
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�������������	��	��  ��(����������������	��������������(���� ��
����	�����1��  ��(�����������������	��������;���������*
���������1

�'-,9����0������	����� �����������@�����������������
� ����������������������	��	��  ��(���������	�����������������
�����@�������'-,1

Copying with spaces (COPY_S)

�����(������������������	�D�E���������������������DYYE��
�����	��������������0����������(���� ��@�������	�(�	�������	����
�����������	���������1�7�����������������������������������0
����	� ����	�������������������������� ��@���	�����C�����0@
���������	� �������(�	� ����������	1��������� �
����������	� 0�����������'-,9=�������������	���������'-,
������1��'-,9=���C��������������	���������������	���������
��������0�����	����������(���� �������������1

����	�����������������������J�#���'83���.&&,��788�&31

�����	��	����0�����	����	����H'83��.&&,�788I@� ��
�'-,9=�����	�����������������J

^�_���_�

�'-,�S#T�U�>V

�'-,9=�S�T�U=>V

�'-,9��S�T�U=�V

����U=>V�����	����������������0�����	��������J�'83���.&&,
�7881

7���������(��������������������	��������	@������������������
�����������	�����������	� �������	1�6����;�����@�����	��
����(���������������������������������������0�����	�����	
U-&V1�6�������������		��������J

#���%����=��D����������*���=�E�����������+

������������J

ZD�_�YY�_�ZE

�'-,9=�S�T�U-&V

�'-,9=�S�T�����

����	���(��H����������*���=�I����������������0�����	�U-&V1����
����	����������(���������������������������������(���� ��
����1

Copying the closest token (COPY_C)

����������������	�������������0������������������������������
�� ��@�������0������������0�������������������������	���������0@
���������������0��������  ��(������1�����������������	
�������������'-,9��������1

�6����;�����@�����	����������������� ���������������0������J

%�==���5=.��= %� = !$$1$

��������%���������������������	������������������	�D���
�;�����@�%��������E@�0�����0������������0������������
�����������������������0J

�'-,9��S������	���� ��T�U�����F��0F����	V

����������������������������0������	�������!����./4��������
�������������������0�����	1

Moving information (MOVE)

����%').���������������������'-,��;���������������������
����	�D��	������E1�%').����� ����	������(��������������
(���� ����������������0�����	��������������0�����	1

%').�U�>V�U�=V

%').������U=>V
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Concatenating information (CONCAT, PREFIX)

.3 .�������	�������������������������������������(���� �����
����������0�����	1�������������0� �����������	@���������������
(���� ��1�6����;�����@�������������		����������#<����	�#<�
���� �������	����������������	����������������0���������J

^�_�<�_�̂

�'-,�S#T�����

�'>����S�T�����

�'>����S�T�����

�'-,������U�=V

����U�=V�����	����������������������������������D#<�E1

=������0��������	�������0�����	�������������������D���
�;�����@�.��E����������������������0�����	J

3�_�3

�'-,9��S#T�����

�'>����H�H�����

�'>���9��S�T�����

�'-,������U-3V

>����������������������������������������������������	�������
(���� ��1�������������������	� ��� �����	� 0��������������
	������0������������������0�����	J

3�_�3

�'-,9��S#T�U-3V

�'>����H�H�U-3V

�'>���9��S�T�U-3V

�����'>���9�������������	������������'>�����;�������������
���	��	��  ��(��������������������	������	������������	���1

����-&.67R�����������(���� �����������;��������������	���1
�'>�����		����������	��������������	�-&.67R��		�������
 �������������������1�����������������-&.67R����������0� ����
������	@����������@����������(���� ��1��������������0� �������
(���� ����������������0�����	1

�'-,�H���&8.=I�����

-&.67R�H=�7>�I�����

����(���� ����������������=�7>����&8.=1

����-&.67R9�������������	���������;��������	��	��  ��(������
�����	������������	���1��������������� �����������	1

�'>������	�-&.67R��������� �����������J

�'>����S#TD�JF�E�U=>V

��������������������	���������������������������������	�����
 �������������	�����������������������	����������������01

�'>���9�����	�-&.67R9������������� �����������N
����(��@������ ����������������������	��	��  ��(���������	
����������������������1

Converting information (CONVERT)

�����'>).&�������������	�������(����	���������	��������
��������� �����������F������	��������1

Introduction (converting place codes)

�������������������������������(�����@����������������
�����	���������	�����������	��������������	�0��������	���
���(����������� �����������������������1�����������������
����������� �����������������������1����������������������������
(����@���	���������	��������������������������(����1�6������
�;�����@�0����������������������H��	�1� �I@�������������������J

$$#��H=78).&�=-&7>�I
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$$��45&�'>=)788.���!$$1$

$$��8�5&.8

1111

>�����������������������	�����������	����	�� ���C����1
=��������������������������������������	���������	�������	�1�c��
������������������������ ��@�������������������0�����������
����	�������	������	���������������������0�������������0� �
��	1�7������� �(���;�����@���������������������������������	
 ����	����45&�'>=)788.���	���0���������!$$�������������
������� ��1���������������������������	����(���������
�����	������������ �(���� ��J

]

�'>).&��S#T�̀ ��	�1� ���
>

��������������������(����	����������������������������1����@���
����� �������������	���������������0�������	����������;�1

Retyping tokens

������������������������0�������������
>1���������������� �
���0��	����������������������(���������������1�7����������
�������	@��������������������������������������1

6����;�����J

G

�'>).&��S#T�̀ �����1� � �
> �

�'>).&��S#T�̀ ����1� � �
> �

�'>).&��S#T�̀ ��������1� � �
> 5

����	����(�������������������������������� ��	��������������
�����������������1�7������������������������(�����@����������
����	� �����0��	������������@��@����51

CONVERT considerations

�����������	���� �����������������@���(���@���	
����	����������� ����������������������������������
�'>).&��������1

����������������'>).&������ �����������	@�����������0�����	@
���������(���� ��1�6����;�����J

�'>).&�������̀ ��	�1� �

�'>).&��U��V�̀ ��	�1� �

���� ����(���	1

.������������������0� ����	�	������������(������ �������
������������J

�'>).&��U��V�̀ 11Z(����Z(������1	��

7������������������'>).&�������������	@������������	�������	
�������������C����	J

�'>).&��P������	Q�P�� ��Q��
>

�'>).&��P������	Q�P�� ��Q��.%-

�
>����������������������� �������	� ��������	�����������01
7�����������	@���������������	� ��������	������������X������
�����������	����������������������������������������������������
�������������	����������������� ��1��7���.%-�����	�	@����
���(���������0���������������������������1�7����������	����	���
����0��������(������ ����������������������	���������������
��	�������������������������@�����������'>).&�������������	
 ���������	�D����������
>�����������������������	�������@
��	�����������.%-������������������������������������������E1

Converting multitoken operands

��������(������������������������	@������������������	� 0
�������������YY�����@����������������������(������ ���	����	���
����������������	��������������'>).&�����
>�����.%-1��7�����
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����	�������������
>@���������������������������0����(����	1
���@�������(����='8�>'�4.�������%�8745�=�'&.=@����
���(������ ���������(������������������������J

����� ���� �

 ���� ����

��������	����	�����������	��	����������������0�����������
���='8�>'�����	� �����(����	����%�8745���	���0�����������
���4.��������	� �����(����	����=�'&.=1

�����(��	�������������@������.%-����������������'>).&�����
 ����	1�7���������@�������� ���	�����������������	����������
������������������1����@�='8�>'4.���� ���������
���������������������������������������������������='8�>'���	
4.���1�������������������0���������'>).&���� �������
���������������������������J

����� ���� H���� ������I

7���������(������ ������������� �����������������������
�����������	������1���������0�����������(����	�(���������
��������0@��'-,���	��'-,9=-���������	�����������������1

Assigning fixed values

�'>).&����0����� ����	�������������;�	�(�����������������	
�����������01�����������������	� 0

�'>).&��P������	Q�P�������Q��.%-�_��
>

�'>).&��P�����F��0F����	Q�P�������Q

6����;�������������������0���������8'=��>�.8.=�����������
��0@�������������'-,�����	� ����	���J

�'>).&��U��V�H8'=��>�.8.=I

%��������������0@�������� ����	�������(�������������	���������;�	
(����J

�'>).&��S#T�H8'=��>�.8.=I��
>

�
>��������������������������������������������(��(�������
�����	@���	��.%-�����������������0���������������������1

������������������0�������������
>1�=��������(�����������
��������(�����������0��������@��������0��������������0�����
�����1

Converting prefixes and suffixes (CONVERT_P,
CONVERT_S)

���������������������0� ��������	��������	��������������@��
�'>).&�F�0������������0� ����	��������������	����	��	�"�
 ��������1��=������������0������������������		���������
��������;�=�&�==.���0� �������������	���������������?�������
����@������;�����@��.==.=�&�==.1��7�������������������
�		������������������������������@�������0����	�������������
��������������	�����	���������������%�7>=�&..�1����
���	�����������������@������'>).&�9-����������0� ����	
����;���������������������������;���	��'>).&�9=�����������;1

Syntax

����0���;������'>).&�9-���	��'>).&�9=����������������
�������'>).&�1�����������	������������������'>).&�9-���	
�'>).&�9=�������������(������ ��1����������	�	�����������
����������������������������������0� ���������	J

�'>).&�9-�P�����Q�̀ �� ��9������
><�.%-�P���0��#Q
P���0���Q

�'>).&�9=�P�����Q�̀ �� ��9������
><�.%-�P���0��#Q
P���0���Q
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P�����Q������������ �����������	@�����������0�����	@�������
(���� ��1

7������������������������������@�P���0��#Q�������������������
�������������� �������	�������������;�D�'>).&�9-E��������;
D�'>).&�9=E������������������1

7�����������������������������@�P���0���Q�����������������������
���������� �������	�������� �	0�D�������E�������������1

Temporary conversion

=���������������'>).&��������@�����������������	����������� �
�������	J��.%-�����
>1�,�����������������	��������.%-���	�@
�������������(������������������������������������01

�'>).&�9=�S#T�̀ ����;1� ���.%-

����	����(������������;�������������������	������	����������
���������������� �������;1� �1

����	������������	�(�������

�.==.=�&�==.

��������� �������0��������;1� �������J

=�&�==. =�&�==. !$$1$

'�����	�S#T�����	� ���������	����������(����J

�.==.�=�&�==.

>������������������������������ ��������������	1�=� �C����
���������������������X��������������	������������;�����	1�6��
�;�����@��'-,9=@��'>���9=@���	�-&.67R9=�����	��������0
�����������	��.==.�=�&�==.���������������1��'-,@��'>���@
��	�-&.67R�����	����0�����������������������1�6����;�����@
��������� �������0����	J

=�&�==. =�& !$$1$

������.==.�=�&�����	� ����������������������(���1��'-,9=
����	������(�� �������	@� ����'-,�����	����0��.==.=�&��
�������	1

�����'>).&��������������� �����������	�D����������;�����E@��
��������0�����	@����������(���� ��@�������C��(�����������1

Permanent conversion

���������������������������	��������	������
>@���������	
��������0������0������0�����������@�����������	�����0�������
����;�D��������;������'>).&�9-E1�����	����������������
�'>).&�9=���������J

�'>).&�9=�S#T�̀ ����;1� ���
>�����

��������������	�(�������

�.==.=�&�==.

��	����� �������0��������;1� �������J

=�&�==. =�&�==. !$$1$

��.==.�����	��������������������D������������������������
�������	�������0������� �	0�������������������	E���	�=�&�==.
����	� ����(����������0���������������;@������;�����@������������
�0��1�6������������������������������������	���C��������������
��J

��_��

7��������0���������	� ������(��@� ��������������	�����������
�����������������1

'�����0�����������0��� �������������;<����;���	� �	01������
�������������	�����	�����@����������������-�������0������1
7���������@���������������	���(�� ��������	���������������+
D���	���������E���	���������������������������������	����0������
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�����;��-�����%��������������@���	���������������������������
����	����0������� �	0��������̂ ������������1�6����;�����J

�'>).&�9-�S#T�̀ �����;1� �����
>���%���̂

�����;1� ������	�������������-������01

' (����0@�������������������0���2������� �	0@���	���0�������
������������� ��������	@������������������������������1

Side effects

'������� ����������� �����(��	�����	�����������������������
��������������������������������1����������;1� ��������
��������������J

=�&�==.�=�&�==.�!$$1

�).>5.��).�!$$1

���������������������<������J

��̂ �_��

���'-,�S#T�U�>V

���'>).&�9=�S�T�̀ ����;1� ���.%-

���'-,9=�S�T�U=>V

��.R7�

�������������J

#������).>5.�44��=�&�==.

����	���������J

#����������).>5.44��=�&�==.

����(��@������������<���������J

��̂ �_��

���'>).&�9=�S�T�̀ ����;1� ���
>��

��̂ �_�G�_���_�G�_�G�_��

���'-,�S#T�U�>V

���'-,�S*T�U=>V

���'-,�S+T�U=�V

��.R7�

�������������J

#������).>5.�44��=�&�==.

����	���������J

#��������� =�&�==.

��	J

���'-,�S#T�U�>V

���'-,�S�T�U=>V

���'-,�S�T�U=�V

����	���������J

#��������� �).

7�����������	@���������  ���<����������������������������
���������@��'>).&�9-<9=����������������������������������	
��������������(���� ��@���������0�����	@���	�������	�S��	��L
�.%-T1�6���������	�S��	��L��
>T@������������������������
�� ��������������������������	����;�����	���	�(�	����0@���	
������������������	����������������;<����;�����������	���������
�� ����������������������;<����;����C�������������	1

Retyping operands (RETYPE)

����&.�,-.������������	����������������0���������������	���
������������ ��@�������������0�����������(����@���	�������������0
�����������  ��(������1����������������������0���������	��J

&.�,-.�P������	Q�P���Q�SP(���� ��Q�_�P�������Q�T
SP(���� ��Q�_�P�������Q�T
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�� ��������������������������	��	�"���������������������������
���������1�-�������	����������� ��	������	@�������	@���	
����(�	������������������ ��1�&���(������������� �
����������	� 0����0������������������������D$E1�>��������
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�		��� �����J
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��������	��	�����J
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�'-,9��S#T�U5�V

�'-,�S�T�U5)V

&.�,-.�S#T�$
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�����������0���������������1

������	�������	����(���� ��������������������;������������1�6��
�;�����@����0�����������������"��������������=�1����&8.=
��	�������������=��������������	�=�7>�J

Yd��_���L�H=�I�_�G

&.�,-.�S#T����H=�7>�I

������������������������0��������(�������=���������	� 0��
����������� ��������	1�����&.�,-.�������������������0��

������	���������������������D�E���	���������������;������
=�7>�1�>��������������

#���=�����&8.=�=�

� �����

#���=�7>�����&8.=�=�

��	��������������������������	��	�^�_���_����������1�>��������������
������	������������0������1����������������� ������0�������
����=�7>����� ������	���	���� ���������������������
����� �������������������������1�>��������������������������	
���������������DYd�E����������������=�������������	�	� 0���
�������1���������������������J

%�7>�=��c5>


����� ��������	��	�"�	�����J

%�7>�=�7>��c5>


���������������	����(���� �����������&.�,-.�������	����������
�������	��	��  ��(��������������������	1�7������������	��
�����	�	@������������	������������������ ������������������
���(����1

6����;�����@

=��#��

��0������=57�.�#��1

=�������������	��	��  ��(�����������=57�.������=�.1�,��
����	����	������������������	��	��  ��(���������������J

�L�LI=�I�_�̂

&.�,-.�S#T��%�H=57�.I�H=�.I

>������������ ������������	���������������������=57�.�#��@���	
�������� ����(����������	��	��  ��(�������=�.1
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6��������������������	���	����������������@���� �������������
��������	1

6����;�����@�����������������

!�#���	�=�

��	����������<������������J

^�_�Q�_��

�'-,�S�TD�E�����

&.�,-.�S�T�̂ �����D#J�E

#�������� �������	��������(���� �������@�#������������������
�������������������	������@���	������������� �������������
D^E1

&.�,-.�������������0��������������������� �0������������	
����������D�E�������(���������DYYE�������� ����	�������D�J�E
�����������	���	�������������0����0����������������������
� ����	���������������������������	1

6����;�����@��������������J

#*�������44�����33��..�66������&3

���������������������<��������������(������	���� �	�������J

^�_���_��

&.�,-.�S�T�$ N=���������66����>588����

^�_���_��

&.�,-.�S�T�$ N�=���������>588����

^�_�D�J�E�_��

&.�,-.�S�T�$ N�=���44���	�������>588����

^�_�F��_��

&.�,-.�S�T�$ N�=���..����>588����

Retyping multiple tokens (RETYPE)

����������������X�������������(���� ���������0�����������
���������������������1�������������������(������������J

P���QYP���Q

�������	� 0������	��	�&.�,-.����������������������������	
S#T1�������� ������� ������������������$�����**���	���	���������
��� ��������������������������	1�A�����������������
���������������	� �������	1

6����;�����@�������0���������	��0�������	��������� ��
������#��F�*�%����=�1@���	�0�������	�����������������(�����
�0�������������������������������1��������� ������������	
 0

$�Y�F

&.�,-.�S#T�$

�����������������0�������	����0���������������1�=������0��
�����	�������0������������������������������������0���������
(��������5
>1��������� ������������	� 0J

��Y�̂

&.�,-.�S#T���H5
>I

�����������������������������	����������������������������������
������������������������	1

SOUNDEX phonetic coding

����='5>3.R������������	��������������='5>3.R���	������
��������0�����	���	���(�������������������������������0�����	1
='5>3.R���	�����������������0�������������������� �������
�����	������������������������1�='5>3.R�������;�������
 ��������(���� �����������������(��0�	���������������	�0������
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 ����	������������������������������������ ������ ������� ��1
����='5>3.R�������������������������������J

='5>3.R�P�����F����	Q�P������F����	Q

6����;�����@�����������J

='5>3.R�U=>V�UR=V

������������='5>3.R�����������������������	���	����������
����������������������������R=���������0�����	1

����&='5>3.R�D��(����='5>3.RE�����������������������
='5>3.R���������;�������������������������	������������	�����
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���� �������	�	� 0���������

Z-'=�9=��&�

��	��������	� 0���������

Z-'=�9.>3

Terminating pattern matching (EXIT)

����.R7�������������	����C������������������������������������
����������������������	1��������(�������������������X������
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�'-,�S�T�U=>V

�'-,�S�T�U=�V

.R7�

>���������������������C����	������������������X���������1

Subroutines (CALL)
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Z.>39=54
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�����0�Z=54�Z.>39=54��������C����	���0� ����	�	1
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���� ������

Z-'=�9.>3

b#�%
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b#�&

��88�&'5�.=

�		������������������	�������

Z=54��-�=

�����������������������������	�������

Z.>39=54

Z=54�&'5�.=
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Z.>39=54
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����	�����������������1
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��������������������������1

�����������������	� ���������������������������������������
Z.>39=54���������	�����������&.�5&>�����������;�����	1����
��������;�����������88��������������������	��������������
� �������1

Returning from a subroutine (RETURN)

����&.�5&>�����������(���� ���������������������������
� ���������������������������1���&.�5&>���������C����	
����	�����0������	��������Z.>39=54���������1
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�����������������������0����������������	��������������	����
����������1

���7'> ='5&�. ��&�.�

.3 .���� ������	 ����(���� ��

������	 ��������0�����	

'��0�%�� ������	 ����(���� ��

������	 ��������0�����	

.3'&�� ������	 ����(���� ��

������	 ��������0�����	

.3 .�� ������	 ����(���� ��

������	 ��������0�����	

������� ����(���� ��

������� ��������0�����	

����(���� �� ��������0�����	

����(���� �� ����(���� ��
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������� ��������0�����	

����(���� �� ��������0�����	

����(���� �� ����(���� ��

!3�� ����(���� �� ��������0�����	

��������0�����	 ��������0�����	

.3'&�� ������	 ��������0�����	

������	 ����(���� ��

Summary

���7'> ='5&�. ��&�.�

.3'&�. ������	 ��������0�����	

������	 ����(���� ��

.3'& ������	 ��������0�����	

������	 ����(���� ��

��������	�����	 ��������0�����	

��������0�����	 ��������0�����	

������� ��������0�����	

������� ����(���� ��
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����(���� �� ����(���� ��

.3 ���� ��������0�����	

����(���� ��

������	
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���������	����3�(������?�
������������������������������
����J

��� �����5�������3��;��� ����8�%�<

���	���(����������7��������(��=���	��	�"��1

=��>.37���������	��F ��	���	���������������"�	����������(�
���	��	�"�������������1�=��>.37������	�����0���;���������
��	�	� �������������	��	�"������������������1�=��>.37�����
��F ����;����� ��������������	������	���/*</!�������	���>�1

�		����������������(�	�	����=��>.37�J

.>�'3-��

=���	��	�"���-�������&����.���0������-������

.>�'3-�������	���������	��	�"���������������������������
��������)�������%��' 2�����1$����� �(�1����)������
%��' 2������C������������������������������ ������	�	�����
.>�'3-��1

4�����������

���:���	�����������.���	�*�
�@�������@�	����

����������	�	�(�����������������������������	� 0�.=&7
�����	�������	���1�40����(������@�����������	�	�(��������
1�����������(����1;����;������1�����������	�	������������������
��(�� ���������	�	����������������������������	���
���	��	�"��������������	����������������1���� ����	@����
��������������������� ������	�	���	�������	����1���1

�G��:��
������������*����

���������(����M���������	�������������	����	�(��������
�����1����������������	������;����������(����������F ��	
�����	���@� �����(�������	��	�"��������	��������	��	�"��
	� ������@���	����0��1�(����	����������������		��=�0��1

���:���6�������*�����������
����	��!��3EN��
�

�������������	��������������������%��' 2�����1$����� �(����
%����������)�����4����1

��*������
�

=������	���������(�	�	�����������	��������������	������	���
	�(��������1�����������	�����������������������������������
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&�	���	�	��� ��1�4����	����������������������������1
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������������9��1	 ������ �������	�	�����������1��@���	
�������1	 ������ �������	�	������	���	1��1

Installation

���������	����3�(������?�
��������������� ���������	� 0
������������1�;�1������������	����������� ������	���������������	
���
������	��1�>������������ ���������	��������0�������	��1���
�������������
��@������		<&���(��-����������������������-����1

Supported platforms

�������
��������������������	�������	���/*</!���	
���	���>�����01

Contents

���������	����3�(������?�
�����������	�������0���������
������������������������ ���	������H������IJ
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1Z4�� ���
��� ����0��;����� �����	�388
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1Z3��� =������	���

1Z.;����� =���������������������;�����

1Z) =����������������������%��' 2������
)�����4���

���������������������������������	�;����������		�������
�������������������������=��>.37�@�.>�'3-��@���	����
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���	��	�"���������������@����� ������	�����������������������1

=��>.37��D=���	��	�"���.	����E

Description

=��>.37��������F ������	��F ��	���	���������������"�	
���������(�����	��	�"�������������1

Usage
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�����;������� �(���������������F�����0���;�����������	
��������#���������������9�		�1���1

6����		��������	�������������� ����=��>.37����	�������������
����@���������	�;�41

ENCODPAT

Description

.>�'3-�������	���������0���������	��	�"������������������
������������������)������	�%��' 2���1��������	��	�"�����
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����	����P��9����Q�P���9����Q

�JZ������Z�����	�Q11Z ��Z����	�����9�		�1;����9�		�1���

Usage

7��=��>.37�@�������.���	��-�����	����������������1

7��3'=�-�����J�.>�'3-���P��9����Q�P���9����Q

Arguments

P��9����QJ��������������������������	��	�"�����������������������1

P���9����QJ����������������������������	�	������������������1

Notes

.>�'3-����������F��0����������0����������������	����?�� �
��	����������	��������1

���@����	��	�"���������������������������� ������	�	�����
.>�'3-������ ����	�������)�������%��' 2���1

Discussion

.>�'3-��������0���C����	��������)�������%��' 2���
�����	���1���������������	����	����0������������	�	��������
���������������0���������������1

Avenue tools and examples

Description

����������	�������0������������������������(������������	
�;�����J

@������8�G�J�=�������(����F ��	������	���1������������
��	��������=����������;�����1

@������#8�G�J��	(����	��������(����F ��	������	���1

�
��
��
8�G�J�4��������	��	�"������������1��������������	���	
���	��	�"���		����(�����������)�� ���	������������������
��3'=���;������1



148 GEOCODING RULE BASE DEVELOPER GUIDE

*F�
,���8�G�J��		��=�0�����������������1�����������	�������
�������		��=�0�����	�������������0���'34�������		�0��1	 1
�.'-54�$1	������� �����	�	��������������1

:�����8�G�������
7��8�G��	����J���0��������������������1����
�����������������������0�������������������	����.	�������	� 0
���)�������01�������0�������������� ���������������
���	��	�"����������������@��������9�		�1��0@��9����1��01

6����		�������������������@����������	�(�	���������1����@
����� ��������0�����0����	�����	������������O�����;�����@�0��
��0����	�������������������������������1

MapObjects geocoding example

Description

�������	��������������������%��' 2�����1$����%��������)����
4����+1$��������	�	1�7��	��������������������������
�����	����� 2�������������������������	����������	������
%��' 2���1

Sample data

=������	���������(�	�	�����������	��������������	������	���
	�(��������1�����������	�����������������������������������
�������)����������	��������������������������������������.=&7?
&�	���	�	��� ��1�4����	����������������������������1
�		����(������������� ����	��������(������ ���������	�	1
������������9��1	 ������ �������	�	�����������1��@���	
�������1	 ������ �������	�	������	���	1��1
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Matching and standardization file conventions and limits D
• Conventions and limits
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Pattern file conventions

=��>.37�<.>�'3-�����C��������������������������������������
�������������� ����������������1

=��>.37�<.>�'3-���������C��������������������������������
���������������1

�� �������������������������� ������������1

Default parsing parameters (STRIPLIST and
SEPLIST)

����=�&7-87=����	�=.-87=����������	�����������������	�����
��������������������������������	���	�����	��������������������1

=�&7-87=��H�@1Z?[NJI

=.-87=��H�DEF<@\]NJI

������������������������� ��������	����C�������������1����
C����������������������0����� ���������������1�7�������������	�	
���������	��	�"�����������@�����	�����������������	1

Limits

����(���������	� ���������������;�����(�����������	���
���)������	�=��>.37�1

ArcView

>�� ����������	���������		����0����������	�����������)���
������������������������D�57E@�������@����������?������	���
����������	������ �;J���

>�� ���������	��	�"�������������DY1�������E���������		��
�0��J��

8�������������������		������������8������	������ �;���	����
�%������01=��
�0���C���J�#$��

Matching specification (*.mat)

>�� ������)�&���������J��*+

=�"���������	�������������)�&���������J���

������������������������	���)�&���������J��**

>�� ������%�������������J��$

Pattern file (*.pat)

>�� ������(���������@�������Y1� ����	�Y1	��J�#$

>�� ���������������������	J��$

>�� ���������F	�����	�(���� �����	���������	���������������
��������J�#*

>�� ���������	�����������������������������	J�#$

8������������F	�����	�(���� �������J��$

8�������������������������F	�����	�(���� ��J��$

>�� ��������;�	���	������������������C�����������	��������
C������������������������������������	�D�����;�����@�b#�Yd���
������C��������EJ��

>�� ���������������������������������	J��

>�� ���������������������������(����������������������	J�#$

>�� ������������J�>�������� �������������	�����������������
���������;���	���#+
� �����

Classification table (*.cls)

8����������������  ��(������J��*

Conventions and limits
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12
actions
������	�������������������������������������2�������������������"�	��		�������	�����0������
�����	������������������@����(����������������	����������(����� ��	��������������� ��@����0�����
(��������������	��������������0�����	����(���� ��@������(��������� �������1

address
��	�����������������������@����������������������������������������������	������������������
������1

address data
%������������������������������������������������� �����������	�����������	���������1����
�		���	������0����������������	�(�	�����		���������� �����������������0��		���1

address data format
���������������������������F�������������������@����������������������������		����������
���������� ��@�������	��������@�����������@��������0��@����0@���	���������	�1

address data model
�����	��� ���	�����	�����������0�����������	�����		��F������	���������@������������@
"���@������@���	��������1�����		���	������	���������������		���	����������1

address element
��������������		��1����������� ��@�������	��������@������������������������;����������		��
�������1

address field
���������������� ��@������������������������		����������1��		�������	����� �����������
����������	���@��		���	���@���� ���1

address format
����		����������	�����������������������		������	��������	���������������������� ����	
�������������������������1

Glossary



152 GEOCODING RULE BASE DEVELOPER GUIDE

address locator
'������������������������������	�������������������������
��� ���������0��F�����������	��������	�����������	���1����
�		�����������	����������������C������ ����	� 0����
�����	��������������������������������		������������������
 �������1���������������������������������� �����������	���
��(������	���������	��������1����������;�������1

Address Locator Properties dialog box
����������0������������������7=���	����������������	��0����
�����	������(���1����������	������(��������������	������ �;
������� ����������� ��������������M���	����%��M1

address matching
=��������	�1

address standardizer
�����		������	��	�"����������0��������������������������
����1�����������������������������	��������������������������
��������������� ��1

alternate name
����		���������������	�����������������		����������1�7�����
�����	������(���@����������(�������������	����������������
����1���������������������� 0�������������������@������
 0���������0���� �����	�������������@��������������(����������
 �������	�	�����������������������������������	��		����������1

API (application programming interface)
=������������������������������������1

application programming interface (API)
��	�����	���	�	��������	����������������������������
������������	�(������������� ���	����������"�����������������
����������1��-7����� �� ���������������������������������
���@��'%@�c�(�@���	�����1

arithmetic expressions
.;������������������������������������ ��P����F�����F������	Q@
P�����F��������Q@����P�����F�����F������	Q1

blocking
'�����	��������	�;���������	����������� ���������������
���������������	���� ��������	1

booster index
�������	������	�;�	�����	������	���������������	��������
���	�	������������	���������1

candidate
���������������	������������������	������������������� ����0���
 ����������������������		��� �����������	1

class
5�	�����������������������������0�������������������� ����	���
�����������������������������		��1����������� ���������
���������1

classification table
�����	��	��=�77������������������	��������� ���������	�������
��	�����������0���	��������0���������������		��@������
�������0�����	�	��������1���������������������0�P����Q1��1
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classifying
��������������������������������������������		�����
���	��	�"����1

client-side address locator
����		�����������������	���	���	��������������������1

command file
�������������������	��������� �������������������
���	��	�"������������	���	�������1����������������
����0�P����Q1��1

comparison threshold
3�������������������0���������� ����������	����������������������
��0���	@���������������������@����	�����������@�	�������@
�����������@���	�����������������������������1�����������
�������	� 0����������������������	@� ������������������������
���	������������������������������������	1

composite weight
����������������	�(�	�����������������������	����������1����
�������������������(�	�������������������������	����������1

CONCAT
��������	������������������������������������������������������
����(���� ����������������0�����	1��������������� �����������	@
���������@����������(���� ��1

CONCAT_A
��������	���������������������������������������������	��	
�  ��(��������������������	1

conditional expressions
.;������������������������������������������	����C����
 �����������	�����0���������������������	1����	�������
�;����������������	��P����F������	Q@�P����������F��������Q@���
P�����F������	Q1

conditional patterns
'����0������������������1����	����������������������������������
������������0���	����������	������������1

conditional pattern values
���	��������(����������������������������0���������� ���
���@�������=�����=�7>�1������������(������0�����
���	��������(����@������	�������������	��������(����@�������
������	��������(����@���	��� ���������	��������(����1�=������
���������	��������(����@������������	��������(����@��� �����
���	��������(����1

constants
>����������������������������	� 0���	��������� ��1�>�����(�
��� �����	�	�����������������������������	�����������
�������1

CONVERT
��������	�����������������������������(����	���������	��������
��������� ��������	���������F������	��������1

COPY
��������	�������������������������������������������������D���
���	����������������	E1�����������������������	�����P�����Q
��	���P������Q1

COPY_A
��������	���������������������������������������	��	
�  ��(���������	�	����������������������� ����������������	�����
������1
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COPY_S
��������	�������������������������������(������� ������
���	������0������0�����1

DEBUG

�0���	��������������	����������������������	��	�"�������
	� ���������	�1

dynamic feature class
�����������������������������������������������	���������
�		������������������		���	������ �������������������� ��	
�����0����������	����������		���	������ ��1

ENCODPAT
'������������������������������=��>.37��������������	���
3�(�������
��1�.>�'3-������������������������0�������������
���������	��������	�����	��	�"������������������������������
���.=&7?������	�������	���1�.>�'3-������(��������=�77
1;��������������� ����0�1��������1

end of field
�������������������������������	�����	� 0�a1��������������������
���������	������������	������	������������������0�����������1�7���
��	��������������������������������������������	������������������1

end offset
��	����������0������������	������������������������1�������	
������������	2��� ���(����������	������������������0���������
��	�����������������������		����������������	� ��������	1
5�������	���������������������������������������������� ����
�����	�	������0��(������ �0��	�������������������������1

EXIT
��������	��������������������������C������������������������
����������������������������������	@����������(�����������
�������<����������������� ������;�����	1

file
�������������	������	���������������������������1

fixed postion specifier
�������������������������������	�����	� 0�b�1�7�������������
������������������������������	�������������������1

floating position specifier
�������������������������������	�����	� 0�Y1�5�	������	��0����
����������������������������������1�������������	�����0
���������������������������������������1���������������������	
���������������������������������������������������	1

GBF (Geographic Base Files)
=�����������������1

GDB
�  ��(�������������	��� ��1�=������	��� ��1

geocode
������������������������;@0�����	������(�����������
	��������������������� 0���������������	�������(����������F
������������������������������������������������	���1

Geocoding Editor
8���������������0�����	������������	�	��������D��������
�;�������������0��	������������������������RO�����;�����@�R=
��	�R&E1
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geocoding engine
'������������������������������	�������������������	��(�����
�����	���� �����1

geocoding index
���� ���������	�������2��������������������	������(���@
	�����	����	��������������������������0�������������
�����	���������1�������� ���������������������� ���	���������
��������������� ������ ����������������	�	�(������������������ ���1
����������	���@�����������	�;�(������������	���	�����0���
�		���C���0���	�����������	�����������������	������	�;1

geocoding platform
������������������0�������������	���������������������� ���
���������������������������7=�����������������������������������
���������������	������(������	������������������������	���
������1

geocoding process
����������(��(�	�������������������		�������0@�������������
�����		��������������������	���@���	�	���(���������� ��
���	�	���DE1���������������	��������������		��@
���	��	�"�����  ��(����	�(����@���������������		��
��������������������0�������������������0@���	�;�����������	�	
���������@������������������������	���@������������������
������������������	�	���@�������������������������	�	���� ��	���
����������������������@���	�	���(���������� ��������1����
��������C�������������������@��������(���������	@���	
�������1

geocoding style
���������������������������	������(������ ����1�.��������������
	�����	�����������	�������������������������		�����	
����������	���1����������	�����0�������������������	���������	
��������1����������;�������1

geodatabase
���� 2���F�������	������������	��� �����������(�	����(���
������������������������	���1��������(���������	��(���	�����
����@������������@���	����������������������1������	��� ��
����������������	��������	�������	����	��������������
	��� ��������������0���1

geographic base files (GBF)
=�����������������1

GEOPUB30.DLL
������)���������	�������	���	0������������� ���0�D388E����
���������)�����1;1�7���;�����		�������������	������C���� 0
�������������� ����D���������������(���E@��(����������F����� ��
��C���1

GETMAXSCORE
����������������;������������������� ��	������1��������1�,��
���0����	�����������������)�����1;1

input event records
7������(���������	��0���(��0� 0������������1����0������	�
���������		���@������������������(�����������	���@������������
�C����������	����������@���	�������������������1

intersection
������������������������������������1�7�������	���@��������
��������������������������������������������1

intersection connector
��������������	���������		���	���������	����������������		��
�������������������������1�6����;�����@���������		��
=1������������3�1�]�.1�������4�(	1@������������	�D]E������������
�������������������������1����������������������	��������
����������������������������������������������� ��1
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keyword
�����������	���������������������		��1������	��	
�  ��(���������� ������	�����������0���	��������1�������1

literals
������������������������������������	� 0��������������������
C����1

location
��������������	������������������	������������������������ ��	
�����������������	������0���1�7�����������	���������@����
�����������	�����	���������;@0�����	������(����������	����������
	�����������������������������C��������	������������������
����������	���1

m probability
������� � ����0��������������	���������(������������	���������
�����1���������� � ����0��������������������������������������	���
��������	������	1��������������� ���������	��@����������������
����� � ����0������ �1

MATCH commands
5�	���������0����������������0��@���������0�����	@�(���� ��
����@������������� � ������@���	��		����������������������
	�����������������������������(���� ��1

match file
�������������������	��������� ��������	������(���� ����������
�		������������	���������������������������� ������ ��1����
���������������0�P����Q1���1

matching
-����������	������	����	�	�������������	�����	F 0F����	
����������������	�����������������������������	�	���1

match key
����	�	����������������������������������@���	����	��������	
���������������		�����������������������	��������� ��1

match key contents
������������0�����	������������	���� ����1

match key dictionary
�������������������	��������� ��������	����������	�����0��@�����	
������@���	�������(�������	�������������������0�����	1���������
�����������0�P����Q1	��1

match key fields
6���	�	�����	����������������0�	��������0������������������	���
�0��@�����	�������@���	�������(�������	�1

MatchRules
3������(���� ������������		������������	����������������������
����� ������ ��1

match score
��(����������	���������������������	�	�����������		��������1
����������������� ��	������������������������������	�������
����������	���������������������		���	���� �����������	1

minimum match score
����������������������������	�	�������	���� ������	���	���
���������	���������1�����(��������	2��� ���������������	���
=��(����-���������	������ �;1

MOVE
��������	����������������������������(��������(���� �������
��������0�����	��������������������0�����	1������0�����(�
���������������������������	@���������������	�����������������
��(�	1
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negation class qualifier
��C�����������������������������	�����	� 0�d1�����C�����������	�����
>'����	�����������������0��������;��������������0��1�7������ �
��� ���	������������������������0�������� ���������������������1

normalized
������������������D�;������������)�����1;E������������������	
��;�����������������������	���� �� �������$���	�#$$� ��	���
���������1�>������"�������������������0����������������	��
���������������	����������������1

operands
��������������������������	���������������1�-������������������
�������������� ���;�����	����������������������	1

OUTFILE

�0���	��������������	������������������	� ����������������
P����9����Q1

parsing parameters
3�������������������������	�����������	����������������������
���������������	���	�����	��������������������1

pattern–action sequence
-�����������������	����������������������������������������
���2�����������������������1���������������������������������0
�������X��������C��������0�������1

pattern classes
.��������������		��������������	�������������������������
������������1�=�����;���������������������������	�������������
���@������������ ��������	@���	��������1�����1�����������
�������������XA1

pattern file
�������������������	��������� �������������������������������	
��������������	��	�"��������		�����	����(����������
�������"�	�������	��������������0�����	1����������������
����0�P����Q1���1

pattern rules
&�����������������������1����������������0������������������J
���	����������	������	�������1�=����������	������������������	
�����	���������������1

place name alias
���������������������������������������@��������������������
�����@��������@�������������	����1�7�������	���@����������	���
��(�������� ��	�����	�����������	��������������������������
������������������������1

PREFIX
��������	���������������������������		����������������	
������	�������� ���������������������1

PREFIX_A
��������	�������������������������������;���������	��	
�  ��(������������	������������	���1��������������� ����
������	1

prefix values
)������������		�����������������	��������;�� 0�����1�������1
6����;�����@���������		�����*������=�����%������4�(	1@����
�����������;�(����1

primary reference data
�������� ����������������������������	�����������	������(���@
�����0������������������������0���������������	�����������	
����� ������ ��1
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primary table
��������� ������ ����������	����������������0�����������	���1
4��	���������		������������0���������	@����������		��
������������ ����������������������0��� ��1

qualifier
��0� ����������������������������C�����������������������������	
����1�6����;�����@�����d�0� ���C��������������������� ��>'�1�7�
����d���������	����3@���	�����	����������������@����������C��������
��	������>'�������1

reference data
�����������������������������������������������	��		��
������������������������������1�&���������	����������������
�������������������������������	���@�����������	������ ������ ��@
��	����������	������	�;�1����������������������� �����	����
����������������� ���������������	���	�����������	���1

���������������������	���������		���	������	�����	������
�������������������������������������	������(���1

reference files
������������������(���������	���	��������@���������������
D�����������������������	�����������������4���6���E������������
���������	���������1����0�����(��0������������	�����"�	
 ���	��0��������������������;��		�����	�������	������(��
���������������	����������������1

region
���������	@������0������@���	�������������������������������
������1

rematch
��������������������������������	������������������
��������1

RETURN
��������	�����������������������������������������������
� ���������������������������1

RETYPE
��������	������������������������������0���������������0��������
������	���������������� ��@������������(�����������������	@���
������������  ��(�������������������	�������������	�������
��������������� ��1�,��������������0������������	����������
���@����������������������0�����	���������������;������������1

reverse floating position specifier
�������������������������������	�����	� 0�\1���������������
���������������������������������������@��;�����������������
������	�������������������������	�����������������1�=������
�������������������������1

rule base
��������������������������	���������������	��������������������
���	��	�"���		���	������	�����������������������	������������
��������������	���1�.���������	�����0�������������������������
����� ��1

SDE®

=���=�������3��� ���.�����M1

secondary reference data
���������������������	�����������	������(����������������	���
 �0��	�����������0�����������	���1��������������������
����������������� �������������������������� ��1����������0
 �������������������������		���	������	��������������
��������1
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SEPLIST
����������������������0� �����	����	�������������������1
=�����������������������1

series of conditional values
=�������	� 0�	�����������������	��������(���������������������
��������1

server-side address locator
����		����������������������������	�������������������
�������������������� ��������������������1�=��(��F�	�
�		����������������������(�����(���� ����(�������7�������@
(���������������������@����(���������=3.���(��1

shapefile
��(������	�����������������������������������������@�����@���	
����� �������������������������1������������������	�����������
������	��������	������������������������1

side offset
��	�������������������������������1������	������������
�	2��� ���(����������	������������������0����������������������
����		����������������	� ��������	1�5�������	������������
��������������������������������� ����������	�	������0��(�����������
�������1

simple conditional values
3�����	� 0������C�����0������������	���(����1������C�����0
������������� �����������	��	�"�	��  ��(���������	�������������
������(����������C�����0��������������	1

single token
����������������������������������	�����	� 0�����������	�D]E1

Soundex
�����	�;���������0���������	��������������������������������
���	�	���1

Spatial Database Engine™ (SDE®)
��������0�������������������������������������	��� ��
�����������0����D&34%=EO�����;�����@�'������@�%�������
=W8�=��(��M@�7������;�@����34��1����=3.����������@�����F
�������������������	������(�������������0�������<��(��
�����������������������������������������������������	�������
�����@�����	������������	���1�7����� �����������	���������=3.
�����#///1

specifier
��0� ��������������������������������	� ���������������
�		����������������������������1

spelling sensitivity
����	����������������������	������(�������������������������
��������		�������������������		���	������������		����������
�����������������	���1

standardization
#1 ������������		����������������������������		������ �

������	����������������������	���1

�1 �����F����������������	��	�"��	���1����������������(��(�
����������������������������@���	���������	�������(��(�
���������������(����������������1

standardization process
�����������	��	�"������������	�DP����Q1��E@�����������0
	��������0����������(�����		���DP����Q1	��E@������������������ ��
�������(�	�������	��	��		����  ��(�������DP����Q1��E@���	
����������	���������������	��	�"��������		���DP����Q1���E1
�������	��	�"�������������������������	���		����������������
�� ��1
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STANEDIT
�������	���(���������7��������(��=���	��	�"��1�7������	����
�������������0���;������������	�	� ������1

STRIPLIST
����������������������0� ������ ��������	�	���������
���	��	�"�����1�=�����������������������1

subfield classes
���������������������������	���������������	�(�	�������	������O
�����1����0������������#����/���	�F#����F/1����0��������������
����������		�������;�@�������#��F��%����=�1

subfield ranges
����������������������������	���������0�������������������
���	1�=� ����	������������������	���D ��J��	E1

subroutines
�����������������������������������������	������������������������
���������D��������88937&.��7'>=@�������37&.��7'>=��
����� �������E1

table of conditional values
����=�77��������������������������������	��������(����1��� ������
�������	� 0�̀ P�� ������������Q1

token
��	�������	����	@������@����0� ������������������������������1

token type value
��(����������	�����������������(�������������		��� 0�����1��
����1

tokenizing
����������������������������������������������		��������	��
�����	����1

u probability
������� � ����0��������������	���������(������������	�������
��������	�D������@�������� � ����0��������������	���������
���	��E1

unconditional patterns
'����0������������������1�5����	������������������������������
���������������������(���������(������������������	1

universal class
��������������������������	�����	� 0�YY1��������(��������
����������������1�7������ ����� ���	������������������	���
���������������������  �	� 0��������1

user interface
���������	���������������� �����������������	������������1�7�
���������	�������������@���������������������������
����������@����%��@���	�������� �;M������������0
�������	�	������ �;�1

VAR commands
������	���������������������	���������0�(���� �������@�����	
�������@�����	�������@���	�������(�������	�1

variables
���� �������������������������������0��1�7���������@�����0�������
�������������(����1�7�����������@�����0���������������������(����1

VARTYPE commands
�������������������������������������0�����(��	�����	����
%����&���1�7������������@� ���)�&�,-.���	��������������C����0
����0�����?�� ����������	1



GLOSSARY 161

Web service
������������������������� ����(�����������	���	���� ����
�����������������������1��� ���(�������� ������������	���0
���	��	�������R%8���	�='�-���	@����@���������	����	���
�����0����������������������0���������������������������@
��������������������������	����������������������1

ZIP
#1 A����7����(������-���1�A7-���	���	�����������������

�����������	���(��0�����1

�1 ������������	��0������	� 0�����5����	�=�����-����
=��(���1

zone
�		��������������������� �������������������		��@���	���
����������������	������������	������������������	1��		��
����������	�������������	�������������������0@���������	�@���
������0�����������������"���1
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